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NOTICE

Read this manual before working with the product. For personal and system safety, and for optimum 
product performance, make sure you thoroughly understand the contents before installing, using, or 
maintaining this product.

Within the United States, Emerson has two toll-free assistance numbers.

Customer Central: 1-800-999-9307 (7:00 a.m. to 7:00 p.m. CST)

Technical support, quoting, and order-related questions.

North-American Response Center: 

Equipment service needs.

1-800-654-7768 (24 hours—includes Canada)

For equipment service or support needs outside the United States, contact your local Emerson™ 
representative.
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Failure to follow safe installation and service guidelines could result in death or serious injury.

 Make sure the Rosemount 5708 is installed by qualified personnel and in accordance with applicable 
code of practice.

 Use the equipment only as specified in this manual. Failure to do so may impair the protection 
provided by the equipment. 

 Inappropriate or incorrect use of the product may result in hazards and application-specific 
malfunctioning, such as vessels overfill or damage to system components, through incorrect 
mounting or adjustments.

 Do not perform any services other than those contained in this manual unless you are qualified.

 Any substitution of non-authorized parts or repair, other than exchanging the complete transmitter 
head or antenna assembly, may jeopardize safety and is prohibited. 

 Unauthorized changes to the product are strictly prohibited as they may unintentionally and 
unpredictably alter performance and jeopardize safety. Unauthorized changes that interfere with the 
integrity of the welds or mounting plates, such as making additional perforations, compromise 
product integrity and safety. Equipment ratings and certifications are no longer valid on any products 
that have been damaged or modified without the prior written permission of Emerson. Any 
continued use of product that has been damaged or modified without prior written authorization is 
at the customer's sole risk and expense.

Explosions could result in death or serious injury.

 Verify that the operating environment of the transmitter is consistent with the appropriate hazardous 
locations specifications. 

 To prevent ignition of flammable or combustible atmospheres, disconnect power before servicing.

Electrical shock can result in death or serious injury.

 Avoid contact with the leads and terminals. High voltage that may be present on leads can cause 
electrical shock.

 Make sure the main power to the Rosemount 5708 is off and the lines to any other external power 
source are disconnected or not powered while wiring the transmitter.

The products described in this document are NOT designed for nuclear-qualified applications. 

Using non-nuclear qualified products in applications that require nuclear-qualified hardware or 
products may cause inaccurate readings. 

For information on Rosemount nuclear-qualified products, contact your local Emerson Sales 
Representative.

This product is designed to meet FCC and R&TTE requirements for a non-intentional radiator. It does 
not require any licensing whatsoever and has no tank restrictions associated with telecommunications 
issues.

This product complies with part 15 of the FCC rules. Operation is subject to the following two 
conditions: (1) This product may not cause harmful interference, and (2) this product must accept any 
interference received, including interference that may cause undesired operation.
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Introduction

Section 1 Introduction

This reference manual provides detailed product related information, installation, setup and operation 
instructions for the Rosemount™ 5708. The manual is designed for trained personnel. Read it entirely 
and carefully before unpacking and installing the products.

1.1 Product recycling/disposal
Recycling of equipment and packaging should be taken into consideration and disposed of in 
accordance with local and national legislation/regulations.

1.2 Storage and transport
The Rosemount 5708 is protected by special packaging during transport, and is guaranteed to handle 
normal loads during transport.

Indication of a potentially dangerous situation, which could result in serious injury to persons and/or 
damage to the Rosemount 5708.

Procedures and instructions in this manual may require special precautions to ensure the 
safety of the personnel performing the operations. Information that raises potential safety 
issues is indicated by a warning symbol. Refer to the safety messages listed at the beginning 
of each section before performing an operation preceded by this symbol.

An indication of special instructions relevant to installations in hazardous locations.
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Section 2 Overview

Theory of operation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 3
Applications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 3
Components of the Rosemount 5708  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 4

2.1 Theory of operation
Rosemount™ 5708 delivers accurate volumetric measurement of bulk solids and powders – regardless of 
material type, product characteristics, storage silo type, size, bin or container, and harshness of the 
storage environment. The product incorporates unique dust-penetrating technology to achieve an 
unrivaled degree of process measurement and inventory control.

The Rosemount 5708 include an array of three antennas that generate low frequency acoustic signals 
and receive echo signals from the contents of the silo, bin, or other container type. Using these antennas, 
the unit measures not only the time/distance of each echoed signal but also its direction and generate a 
coordinate of the echo inside the vessel.

The built-in digital signal processor digitally samples and analyses the echoed signals and produces 
accurate measurements of the level and volume of the stored contents, and can generate a 3D 
visualization position and form of the material within the container for displaying on remote computer 
screens.

2.2 Applications

2.2.1 Wide application range
The Rosemount 5708 can measure practically any kind of solid material, stored in a variety of containers, 
including large open bins, bulk solid storage rooms, stockpiles and warehouses, mapping loads that 
randomly form over time inside silos, and many other challenging applications that were not possible 
until now. The Rosemount 5708 can measure ranges of up to 230 ft. (70 m) and generate 3D 
visualization of the material surface when installed according to the guidelines within this manual.

2.2.2 Advantages
 Non-contacting measuring principle, easy to service and maintain
 Measures minimum and maximum levels
 Suitable for measuring all solid materials (including ones with low dielectric constants)
 Operates in dusty and moist environments
 Profiles of adhesions of materials to vessel walls
 Self-cleaning antenna
 3D mapping visualization tool that can be used for assistance with choosing a filling location for even 

distribution of material (in vessels with multiple filling points)

 Includes three transmitters and three receivers integrally assembled into a single unit
3Rosemount 5708 Overview
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2.2.3 Models
The Rosemount 5708 consists of three sub-models: Rosemount 5708L, 5708V, and 5708S. All meet 
safety approvals outlined by ATEX, FM and others. 

Rosemount 5708L

The model determines the average level of the stored contents and average distance from the 
Rosemount 5708 to the surface of the material. The Rosemount 5708L is suitable for narrow silos.

Rosemount 5708V

The Rosemount 5708V models yield highly accurate readings of level and volume. It is appropriate for 
vessels of up to 40 ft.ft. (12 m) in diameter and at least twice as high, open bins and stockpiles. It 
presents the minimum and maximum Level/Distance measurements along with the calculated average 
and volume.

Rosemount 5708S

The Rosemount 5708S models have the capability of generating a 3D visualization of the stored contents 
on a remote computer and to be mounted with additional devices in the same vessel. These features are 
highly useful for mapping build-up loads that form randomly over time and other irregularities and for 
monitoring inventory in large vessels.

2.3 Components of the Rosemount 5708
The Rosemount 5708 is divided into two parts:

 Antennas

 Head

Figure 2-1. Components of the Rosemount 5708

A. Head
B. Antennas

A

B
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The antennas contain:

 Three antennas, sealed with a customized tin foil

 2.04-in. (52 mm) thread to fasten the Rosemount 5708 to a mounting plate and a fastening nut

 Temperature sensor

 Sealing rubber O-ring

 Orientation indications

The head contains:

 The electronic board 

 One gland and one blind gland

 Grounding screw

 Fastening screw to the transducers
5Rosemount 5708 Overview
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Section 3 Mechanical Installation

Installation procedure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 7
Mounting considerations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 7
Moisture and water condensation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 8
Physical mounting  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 17

3.1 Installation procedure
 Make sure all required documentations are available: Application Evaluation Form (AEF) and Vessel 

Drawings.

 Compare locator suggestion or mounting location as suggested by Emerson™ with the actual 
Rosemount™ 5708 mounting positions. 

 Perform manual measurements of the vessel dimensions, and compare results to the drawings. 

 Check 24 Vdc input to all Rosemount 5708. 

 Check RS-485 link between Rosemount 5708 and the other side. Make sure the resistance between D+ 
and D- is 60 ±5% Ω. 

 Check 4-20 mA connection to the local PLC. Perform Current Simulation from the Rosemount 5708 
connected to the PLC.

 Power up the Rosemount 5708 and check polling address.

 Set polling address. In daisy chain connection make sure that each Rosemount 5708 has a different 
polling address and one of the Rosemount 5708 is set with polling address of 00. 

 In case of daisy chain connection, write the polling addresses on the vessel drawings for all Rosemount 
5708. 

 Verify every Rosemount 5708 for proper functioning after power up. This can be verified by connecting 
each device directly to a computer. 

 Verify sound signals transmission from all Rosemount 5708. 

 Get material status (level/distance/volume) according to the process manager. 

 Get all required information from the process manager in order to complete the Rosemount 5708 
configuration. 

3.2 Mounting considerations
This chapter describes the necessary steps for proper installation of the Rosemount 5708 beginning 
with important pre-installation considerations such as environmental conditions, correct positioning 
and orientation, through the mounting and configuration process. 
7Mechanical Installation
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3.2.1 Location and positioning guidelines
Choosing the proper location to the unit should consider every aspect of the vessel and contained 
materials, including the silo or vessel dimensions, type of material and angle of repose, locations of filling 
and emptying points, maximum level of material, internal construction and moving parts and any other 
consideration which may possibly affect the performance. 

Note
It is strongly recommended to install the unit according to the Locator PC software results provided by 
the factory for installation location and positioning. Contact Emerson Customer Support for assistance.

Moisture and water condensation
Use the recommended cable gland and tighten the cable connection. For additional protection against 
moisture, lead the connection cable downward in front of the cable entry. Rain and condensation water 
can thus drain off. This applies mainly to mounting in areas where moisture is expected (e.g. by cleaning 
processes), or on cooled or heated vessels.

Pressure
The process fitting must be sealed in the case of a low/high pressured vessel. Before usage, verify that 
the sealing material is resistant to the stored medium. The maximum allowed pressure is indicated on 
the type label of the sensor.

Installation location
Choosing the proper installation location for the unit is an important part of the installation process. The 
wrong mounting location may result in erroneous measurements or loss of performance.

The following factors must be taken into consideration while choosing the installation position: 

 Vessel dimensions

 Filling and emptying point locations

 Internal structure or support 

Other restrictions related to the proximity of noisy devices (such as electrical motor) and any other 
element which may affect the proper operation of the Rosemount 5708.

Note
When mounting the Rosemount 5708, do not install it near the vessel wall. Installing it near the side wall 
will result in bad performance and will not be supported. The Rosemount 5708 cannot be
mounted at a distance less than 24-in. (600 mm) from the wall or filling points.

Installing at the center of the vessel is not recommended, since the perfect symmetry from all sides 
toward the Rosemount 5708 may affect the resolution of the echo. 

3.2.2 Rosemount 5708 orientation

Mounting direction
Mounting at a specific direction is important. The ridge on the antenna and the notch on the top of the 
thread (representing antenna no.1) should be directed toward the center of the vessel.
8 Mechanical Installation
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Figure 3-1. Mounting Direction 0° Indication toward Vessel Center

Figure 3-2. The 0° Indication

Standpipe mounting
When mounting using a standpipe it should be assembled and positioned at a height that leaves at least 
0.4-in. (10 mm) below the standpipe, for the antenna end protrudes, as shown in Figure 3-3.
9Mechanical Installation
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Figure 3-3. Standpipe Mounting

Note
Any obstruction as well as rails, frames or support beams should never interfere with the acoustic beam 
transmitted and received, as shown in Figure 3-4.

Figure 3-4. Avoid Interference with the Acoustic Beam

Inflowing material
Do not mount the Rosemount 5708 in or above the filling stream, or close to the stream, or in the filling 
stream. The Rosemount 5708 should be located with a clear line of sight to the top of the material at 
high levels, where it will not be affected by the filling stream or the noise it creates.

0.4-in. (10 mm)
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Figure 3-5. Inflowing Material

When choosing the installation location, consider the filling and emptying points and maintain at least 
24-in. (600 mm) from the filling point.

Fitting
The fitting area should be prepared to ensure the antennas are positioned perpendicular to the ground, 
as shown in Figure 3-6.

Figure 3-6. Keep the Antennas in Vertical Position to the Ground

Minimum 
24-in. (600 mm)

90°
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3.2.3 Mounting location
 Mount Rosemount 5708 perpendicular to the ground.

 Keep necessary distance from side wall.

 Keep necessary distance from filling points.

90°

Minimum 
24-in. (600 mm)

Minimum 
24-in. (600 mm)
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 Make sure there is no obstacle below the Rosemount 5708.

 In the case of standpipe mounting, assemble and position the Rosemount 5708 at a height that leaves 
at least 0.4-in. (10 mm) below the standpipe for the antenna end to protrude.

3.2.4 Site preparations
Prior to installation, complete and verify the site preparations described in this section. For optimal 
installation, ensure the Rosemount 5708 can be positioned and fitted according to the guidelines in 
“Mounting location” on page 12.

Minimum 0.4-in. (10 mm)
for standpipe mounting
13Mechanical Installation
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Recommended tools for installation:

 A set of small precision screwdrivers (for the terminal blocks)

 13 mm open wrench

 4 mm Hex key (preferably with a handle)

 Large adjustable wrench

 Wire cutter, pointed pliers, insulating tape

 Laser measurement device or equivalent

 RS-485 to USB converter, including drivers

 120 Ω (RS-485) resistor 

 250 Ω (HART®) resistor

 PC or laptop

 DC voltmeter and Ohm meter

Complete the following steps before installing the Rosemount 5708.

Power
 Make sure grounding is done properly. Connect one end of the cable shield to the power ground. It is 

highly recommended to have the same potential grounding to all the Rosemount 5708.

 Prepare a 24 Vdc power supply near the Rosemount 5708 mounting location.

 Make sure that you use proper cables for wiring. The Rosemount 5708 is a 4-wire device. The voltage 
supply and data output (4-20 mA) are carried along two separate two-wire connection cables.

Communications
 For RS-485 communication, use shielded, twisted-pair cables with 120 Ω impedance. Make sure the 

cables are approved for RS-485 communications.

 Route communication cables in proper conduits. Use a proper cable type.

 For 4-20 mA communication, use shielded, twisted-pair, low resistance cables. Make sure the cables 
are rated for analog signals.

 For daisy chaining, a single 4-wire cable can be used, both for RS-485 and the 
24 Vdc power supply.

3.2.5 Site and installation information
The information listed on these pages is necessary for configuration of the device.

Material characteristics

Material name:

Material density:  lbs/ft3 tons/m3 Angle of repose:

Max. temperature: °F °C Maximum pressure: Bar PSI
14 Mechanical Installation
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Vessel type and dimensions

Vessel details(1)

1. Required Field - Accurate Vessel dimensions are required to allow optimal Rosemount 5708 location determination.

 ft  m

Vessel type Cylindrical Rectangular

Top shape

 Flat  Flat

 Cone  Pyramid

Top diameter (A): ______ 
Height (B): ______

Height (A): ______ X: ______ 
Y: ______

 Dome

Height (A): ______

Center shape

 Cylinder  Cube

Diameter (A): ______ 
Height (B): ______

Height (A): ______ X: ______ 
Y: ______

Bottom shape

 Flat  Flat

 Cone  Cone

Height (A): ______ 
Bottom diameter (B): ______

Height (A): ______ 
Bottom diameter (B): ______

 Pyramid  Pyramid

Height (A): ______ X: ______ 
Y: ______

Height (A): ______ X: ______ 
Y: ______

B

A

Y

X

A

A

A B

Y
X

A

A

B

A

B

Y

X

A

Y

X

A
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Vessel details

Rosemount 5708 and filling locations

Figure 3-7. Filling Port Locations

A. Rosemount 5708 (X1, Y1)
B. Fill (X2,Y2)

 When mounting more than one Rosemount 5708 on one silo the location of every device must be 
specified.

 When the application has more than a single filling point, all other filling points must be specified as 
well.

Internal structure like: Ladder, pipe, window, screw, door, rail, support beam or any other obstacle
which is visible to the 5708 scanner. Drawings should be available.

Internal movement: YES NO If yes, please describe:

X Y Offset from roof

1st Rosemount 5708 location:

2nd Rosemount 5708 location:

3rd Rosemount 5708 location:

Filling location:

+Y

-Y

+X-X

B A
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Full and empty calibration
 Full and empty calibration levels are measured from the top of the vessel.

 The full and empty calibration levels represent the 20 mA (100%) and 4 mA (0%) of the volume 
respectably.

 The Rosemount 5708 has a 20-in. (0.5 m) dead zone starting from the top part of the antenna 
assembly.

Figure 3-8. Full and Empty Calibration in Rectangular and Cylindrical Vessels

Application process

3.3 Physical mounting
Step 1: Check power and cables
1. Check the 24 Vdc with a voltmeter.

2. Check the resistance of the data communication lines. 

3. Verify 60 Ω of resistance when connecting the 120 Ω resistors at both ends. 

Full calibration: ft m

Empty calibration: ft m

Maximum filling rate: lbs/hour tons/hour

Maximum emptying rate: lbs/hour tons/hour

Total capacity when vessel is full: lbs tons
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Step 2: Install the mounting plate
1. Verify the O-rings on the neck tube are in place.

2. Remove the nut from the neck tube.

3. Place the mounting plate over the neck tube.

Note
Make sure the hole diameter (D) in the center is 2.05-in. (52 mm).

D
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4. Replace the nut and tighten it over the neck tube to the mounting plate.

5. Lower the antenna and mounting plate into the fitting location on the silo.

6. Bolt the mounting plate onto the flange of the silo.

Step 3: Rotate antenna toward silo center
1. Slightly loosen the nut that connects the antenna with the mounting plate.

2. Rotate the antenna. The notch on the top of the thread must be directed toward the center of the 
silo.

3. Tighten nut.
19Mechanical Installation
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Step 4: Install head
1. Remove the rear panel.

A. Hex key (4 mm)

2. Remove the cable clamp.

3. Verify the presence of the O-ring on the tube neck.

4x

A
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4. Gently insert the antenna cable through the Rosemount 5708 head.

5. Insert the Rosemount 5708 head onto the neck tube.

a. Rotate the Rosemount 5708 head to the desired direction.The head may be installed in six 
different positions. To avoid direction confusion, we can recommend to install the head in the 
same direction as the antennas.

b. Make sure to push the head all the way down until it fully contacts the top of the neck tube.

A

A. Antenna cable
21Mechanical Installation
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6. Tighten the front screw.

7. Re-mount the cable clamp.

8. Gently connect the antenna cable connector. Make sure the latch is clicked and locking the 
connector.

A

B

A. Hex key (4 mm)
B. Open wrench (13 mm)
22 Mechanical Installation
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Section 4 Electrical Installation

Grounding . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 23
Cable selection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 23
Hazardous areas . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 23
Wiring . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 24
Different connection methods  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 29

4.1 Grounding
The Rosemount™ 5708 must be grounded electrostatically:

 For internal grounding, use the power cable ground.

 For external grounding, use the earth potential equalization of the plant.

4.2 Cable selection
Make sure to select the proper cable for each application. 

 For RS-485 communication, use shielded, twisted-pair cables with 120Ω impedance. Make sure the 
cables are approved for RS-485 communications.

 For 4-20 mA communication, use a low resistance cable and make sure the cables are rated for analog 
signals.

 For daisy chaining, a single 4-wire cable can be used, both for RS-485 and the 
24 Vdc power supply. Make sure only to use a proper cable gaging (AWG).

 Use 8-13 mm (20-24 AWG) diameter cables to ensure proper and effective sealing of the cable gland 
entry opening.

 Select a cable suitable for application (indoor or outdoor) and safety certified according to national 
regulations.

4.3 Hazardous areas
In hazardous areas you should take note of the appropriate regulations, conformity and type of 
approval certificates of the sensors and power supply units. For further information on 
regulations, see Appendix A: Specifications and Reference Data. For more information on sensors 

and power supply units, see “Wiring” on page 24.
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4.4 Wiring
The units can be connected in different modes and configurations for different external systems such as 
PLC or DCS and communications on RS-485, Modbus® RTU, and also to RS-485 bus converting adapters 
to communication gateways such as Rosemount LinkPro for GMS or GPRS data relay and TCP/IP gateway. 
For in-depth details and explanations on wiring and communication, refer to “Different connection 
methods” on page 29.

Communications

Note
If electromagnetic interference is expected, usage of a screened and twisted wired cable is 
recommended for the signal lines, which should be connected to the ground reference.

Power supply

For detailed information on power supply specifications, refer to Rosemount 5708 Product Data Sheet. 

4-20 mA 4-wire: The power supply and signal current inputs must be carried over two separated pairs.

Connection procedure

For detailed information on the connection procedure, see “Different connection methods” on page 29. 

Note
Use direct connection between the Rosemount 5708 and the plant (PLC/SCADA).
For a remote connection, use the Rosemount LinkPro remote connection module or a local PC/laptop 
computer as detailed in the following drawing.

Always observe the following safety instructions:
 Connections must be made only in the complete absence of line voltage.

 If over-voltage is expected, overvoltage arresters should be installed.

 Use only a safety-certified power supply with dual insulation between the primary and output for 
powering the unit. The power supply output rating must be limited to 18-32 Vdc, 1A for a single 
Rosemount 5708, and not to be connected to a DC distribution network.
24 Electrical Installation

http://www.emerson.com/documents/automation/Product-Data-Sheet-Rosemount-5708-Series-3D-Solids-Scanner-en-78188.pdf
http://www.emerson.com/documents/automation/Product-Data-Sheet-Rosemount-5708-Series-3D-Solids-Scanner-en-78188.pdf


Reference Manual 
00809-0100-4570, Rev DA

Electrical Installation
November 2017
Using the Rosemount 3DVision to communicate with the units allow the user to choose one of several 
communication types: RS-485, GSM, GPRS or TCP/IP, for more information and details regarding the 
communications, refer to the “Communication methods” on page 91.

Wire the Rosemount 5708
1. Verify the power supply is disconnected.

2. Loosen the compression nut of the cable gland entry.

3. Insert the cable through the cable gland entry.

Always observe the following safety instructions:
 Connections must be made only in the complete absence of line voltage.

 If over-voltage is expected, overvoltage arresters should be installed.

 Use only a safety-certified power supply with dual insulation between the primary and output for 
powering the unit. The power supply output rating must be limited to 18-32 Vdc, 1 A for a single 
Rosemount 5708, and not to be connected to a DC distribution network.

The 4-20mA lines should NOT be connected in multi-drop.
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4. Remove approximately 4-in. (100 mm) of the cable mantle and strip approximately 0.4-in. (10 mm) 
off the edge of each conductor.

5. Loosen the terminal block screws located inside the Rosemount 5708 head.

Note
The two terminal blocks can be pulled out by unfastening the two side screws to allow for easier wiring 
into the terminals. When inserting the terminal blocks back into the head, it is advised to fasten the 
screws back into the electronics card in order to avoid a loose connection and or operational problems.

6. Connect the cable wires according to the wiring diagram. See “Different connection methods” on 
page 29 for different connection methods.

Note
When connecting the last Rosemount 5708 in the chain, a 120 Ohm resistor must be connected as well. 
See Figure 4-6 on page 31. 
In any installation of the 5708 whether it is a single unit on a silo or multiple units, it is mandatory to use 
termination resistors at the ends of the daisy-chain connection.
One resistor must be on the last scanner on the chain (connected to the +/- terminals of the RS485 and 
the other resistor on the other end of the line before converting the RS485 bus to a different 
communication protocol such as USB, TCP/IP and others.

4-in. (100 mm)

0.4-in. 
(10 mm)
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Figure 4-1. Wiring

A. Feed in power supply (18-32 Vdc)
B. 4-20 mA communication terminals
C. RS-485/Modbus RTU communication terminals

7. Connect the external ground terminal.

The Rosemount 5708 must be grounded electrostatically. 

 For internal grounding, use the power cable ground. 

 For external grounding, use the earth potential equalization of the plant.

Note
An internal cable grounding connection is also possible using the inner connection as shown below.

-
+

CB -
+

A +
-
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Figure 4-2. Grounds Screws

A. Internal ground screw
B. External ground screw

8. Tighten the compression nut over the cable gland entry opening.

9. Attach the rear panel back to position and tighten the screws.

A

B

4x
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4.5 Different connection methods

4.5.1 4-20 mA connection
The Rosemount 5708 outputs the % of Volume as set in the configuration and between the Full and 
Empty calibration levels. The 4-20mA current output is available through ports 3 and 4 of the left green 
terminal block (as shown in Figure 4-3). Ports 3 and 4 are the negative and positive poles, respectively.

Figure 4-3. Port 3 and 4

The 4-20mA line is connected directly from the Rosemount 5708 mounted on the vessel to the 
PLC/DCS/Display or any other device (as shown in Figure 4-4).

Figure 4-4. Rosemount 5708 Connected to PLC

A. Active
B. 4-20 mA
C. Passive
D. PLC/Controller

Note
The maximum cable length of a 4-20 mA cable can be up to 2 miles (3 km).

This type of connection is active and not passive, hence the Rosemount 5708 is the active 
module and the PLC should be the passive module.

3 4

D

A

B

C
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Figure 4-5. Wiring the 4-20mA to Emerson™ Wireless THUM™ Adapter

A. Rosemount 5708 housing ground shield
B. THUM Adapter
C. Green
D. Yellow
E. White
F.  Black
G. Red

4.5.2 RS-485 communication
The unit includes an RS-485 communication port. This type of connection allows a PLC/DCS/laptop to 
communicate with the Rosemount 5708. It also allows a connection of multiple Rosemount 5708 in a 
system on the same RS-485 bus and communication with all devices using a single connection to the 
computer running the software.

It is required to use an appropriate cable rated for RS-485, the cable should be of twisted pair, have 
120 Ω impedance and shielded. The total length of the cable should not reach 3280 ft (1000 m).

If multiple units of Rosemount 5708 is connected together, all devices must be connected in parallel 
mode in the RS-485 ports. Hence, all the '+' (positive) ports of the RS-485 should commonly be 
connected and all the '-' (negative) ports of the RS-485 should be connected commonly. The connection 
must be of Daisy-Chain type and have at each of the far ends of the chain 120 Ω resistor (such resistor is 
provided with the Rosemount 5708), as shown in Figure 4-6.

The communication cable must be grounded at one side. This ground needs to be the same grounding 
as the power supply ground.

Each Rosemount 5708 must be configured with a different polling address.

250 Ω

24DC

A

B
C
D
E
F
G
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Figure 4-6. Rosemount 5708 Connection

4.5.3 Communication using the Rosemount LinkPro
In all installations, the Rosemount 5708 can be connected to a GSM/GPRS modem in order to transfer 
the data over the cellular network. The Rosemount LinkPro should be connected on the RS-485 bus just 
like any Rosemount 5708, including cable and resistors as needed. For further details on wiring and 
establishing a connection, refer to the Appendix D: Rosemount LinkPro Operating Instructions.

Note
In such communication mode, only one computer running the Rosemount 3DVision software can be 
connected to the Rosemount 5708.

4.5.4 TCP/IP communication
The RS-485 bus can be converted to TCP/IP communication. TCP/IP to RS-485 converter installation 
should be done as with any Rosemount 5708, including the resistors and daisy-chain 
considerations.

For more information on how to convert and transfer the RS-485 data over TCP/IP, see “TCP/IP” on 
page 92.

Note
Consult the Emerson Technical Support team for assistance on the proper TCP/IP converter to use.

RS-485 (+)

120 Ω
RS-485 (-)

RS-485 (+)

120 Ω

RS-485 (-)

Rosemount 
5708 2

Rosemount 
5708 1

Rosemount 
5708 3

Rosemount 
5708 n
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Section 5 Configuration - Rosemount 5708L 

On-board configuration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 33
Setting the polling address . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 34
Configuring the Rosemount 5708L . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 35

5.1 On-board configuration
The Rosemount™ 5708L can be completely configured via the LCD display. 

It is also possible to configure the Rosemount 5708L by using the Rosemount 3DVision software.

Figure 5-1. User Interface

1. Connect power to the Rosemount 5708 and open the 
front cover.

The Rosemount 5708 initializes a self-test for about 30 
seconds. The display remains blank during this time.

Navigates back within a function menu.
Continuous 3 second press exits to the default 
screen.

Navigates upwards in the navigation list.
Navigates right within a function.

Navigates downwards in the navigation list.
Navigates left within a function.

Navigates to the right when within a function 
group.
Stores a value once configured.

ESC

E
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5.2 Setting the polling address 
Setting the sensor address is mandatory when multiple sensors are connected over an RS-485- 
Multidrop (daisy chain). Set the addresses prior to use of the Rosemount 3DVision software.

2. After initialization, the version screen appears.

According to the factory default settings, after power initiation or 
restart, a screen prompts for configuration.

In the main menu, select Basic Settings.

3. Use the  /  keys to switch between the options.
Press  to select and continue with the settings or  to exit to 
the main screen.

4. When the startup process is complete, the following screen 
appears showing the current average distance measurement.
The top line displays the Rosemount 5708 tag name. By default, 
this line is empty.
Press  to enter the main menu.

1. From the main screen, select the  key to enter the main menu.

2. In the main menu, use the  /  keys to scroll down to Polling 
Address. 

Select  to switch to the Polling Address configuration screen.

3. Use the  key to switch between the two digits. Use the  key to 
modify the value. 
The default polling address is 00. The polling address ranges from 
00 to 63.
Select  to store the modified address and  to exit to the 
main screen. 

 Rosemount
5708LNN
Initialization

 

Initialization
Please Wait...

 m
ft

E ESC

 
<tag name>
3.45m Avg Dist.
█████████████▒▒▒▒▒

Menu E

 <tag name>
3.45m Avg Dist.
█████████████▒▒▒▒▒

Menu

E

 Basic Settings
Advanced Settings
False Echo Mapping
Polling Address

E

 Polling Address
00

E ESC
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5.3 Configuring the Rosemount 5708L

5.3.1 Basic Settings

1. From the main screen, select the  key to enter the main menu.

2. In the main menu, scroll down to Basic Settings, using the  key. 

Select  to switch to the Basic Settings configuration screen.

3. Set the distance units, either meters (m) or feet (ft).

4. Set Vessel Height from the vessel bottom edge to the vessel top 
edge.

Use the  key to switch between the two digits. Use the  key to 
modify the value.

5.   Select the vessel shape, either Cylindrical or Rectangular.

a. Use the  /  keys to switch between the options. Select  
to continue.

b. If Cylindrical is selected, set vessel diameter. 
Use the  key to switch between the two digits. Use the  
key to modify the value. Select  to continue.

c. Set Scanner Height from the bottom edge of the vessel to the 
mounting plate (point above the antenna). 
Use the  key to switch between the two digits. Use the  
key to modify the value. Select  to continue.

 <tag name>
3.45m Avg Dist.
█████████████▒▒▒▒▒

Menu

E

 Basic Settings
Advanced Settings
False Echo Mapping
Polling Address

E

 m
ft

 Set Vessel Height
20.000 m

 Cylindrical Vessel
Rectangular Vessel

 Set Vessel Diameter
10.000 m

E

E

 Set Scanner Height
20.000 m

E

35Configuration - Rosemount 5708L



Reference Manual
00809-0100-4570, Rev DA

Configuration - Rosemount 5708L
November 2017
5.3.2 Advanced Settings
After configuring the Basic Settings, perform Advanced Settings configuration.

d. Set Scanner Distance from Center. 
Use the  key to switch between the two digits. Use the  
key to modify the value. Select  to exit to the main screen.

6.  If Rectangular is selected, set vessel width first (dimension on the 
x-axis). 

a. Use the  key to switch between the two digits. Use the  
key to modify the value. Select  to continue.

b. Set Vessel Length (dimension on the y-axis). 
Use the  key to switch between the two digits. Use the  
key to modify the value. Select  to continue.

c. Set Scanner Height from the bottom edge of the vessel to the 
mounting plate (point above the antenna). 
Use the  key to switch between the two digits. Use the  
key to modify the value. Select  to continue.

d. Set the distance from the x-axis, see Figure 3-7 on page 16.
Use the  key to switch between the two digits. Use the  
key to modify the value. Select  to continue.

e. Set the distance from the y-axis, see Figure 3-7 on page 16.
Use the  key to switch between the two digits. Use the  
key to modify the value. Select  to exit to the main screen.

1. From the main screen, select the  key to enter the main menu.

 Scanner Distance 
From Center
 00.000 m

E

 Set Vessel Width
010.000 m

E

 Set Vessel Length
010.000 m E

 Set Scanner Height
20.000 m

E

 Scanner X To Center
±000.00 m E

 Scanner Y To Center
±000.00 m E

 <tag name>
3.45m Avg Dist.
█████████████▒▒▒▒▒

Menu

E
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2. In the main menu, scroll down to Advanced Settings, using the  
key. 

3. Select  to switch to the Advanced Settings configuration 
screen.

4. Set the distance from the mounting plate (top of the antenna) to 
the Full calibration point / 100% level point.
Use the  key to switch between the two digits. Use the  key to 
modify the value. Select  to continue.

5. Set the distance from the mounting plate (top of the antenna) to 
the Empty calibration point / 0% level point.
Use the  key to switch between the two digits. Use the  key to 
modify the value. Select  to continue.

6. Select  to keep the default setting.
Note: if using an angle adapter, set the angle value.
Use the  key to switch between the two digits. Use the  key to 
modify the value. Select  to continue.

7. Set the process rate using the  key. Select  to continue.

Make sure to always use Regular Process.

For the Slow and Fast Process options, contact your local customer 
service.

8. Set the temperature units using the  key. Select  to continue.

9. Set the displayed parameter desired for the main screen using the 
 key. Select  to exit to the main screen.

 Basic Settings
Advanced Settings
False Echo Mapping
Polling Address E

 Set Distance 
To Full Calibration
 00.500 m E

 Set Distance 
To Empty Calibration
 20.000 m E

 Set adapter Angle

00

E

E

 Slow Process
Regular Process
Fast Process

E

 Celsius
Fahrenheit

E

 Distance
Level
Volume
Analog Output
SNR

E
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5.3.3 False Echo Mapping
When the configuration is finished, set False Echo Mapping.

1. From the main screen, select the  key to enter the main menu.

2. In the main menu, scroll down to False Echo Mapping, using the 
 key. 

Select  to switch to the False Echo Mapping configuration 
screen.

3. Select Map False Echoes for automatically mapping all the false 
echoes up to a certain distance. 
Or select Reset Mapping for deleting the stored mapped false 
echoes from the memory.

Use the  key to go down the list. Select  to continue.

a. If Map False Echoes is selected, set the distance from the top 
of the antenna assembly to the end of the scanning point. 
Always make sure to map false echoes above material level. 
The recommended level is 3 ft. (1 m) above actual material 
level. 

Use the  key to switch between the two digits. Use the  
key to modify the value. Select  to continue.

b. Approve or decline the false echo mapping operation. 
Use the  key to go down the list. Select  to continue.

c. If Reset Mapping is selected, approve or decline the 
operation. Use the  key to go down the list. Select  to 
continue.

 <tag name>
3.45m Avg Dist.
█████████████▒▒▒▒▒

Menu

E

 Basic Settings
Advanced Settings
False Echo Mapping
Polling Address

E

 Map False Echoes
Reset Mapping

 Distance To Map
False Echo
00.000 m

False Echo Area

E

E

 Decline Mapping
Approve Mapping

E

 Decline Mapping
Approve Mapping

E
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Section 6 Configuration - 
Rosemount 5708V and 5708S

On-board configuration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 39
Setting the polling address . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 40

6.1 On-board configuration
For the Rosemount™ 5708V and 5708S only polling address configuration is done using the LCD display 
of the device. 

The rest of the configuration is completed with the Rosemount 3DVision software. For further 
information, see Section 7: Operation.

Figure 6-1. User Interface

1. Connect power to the Rosemount 5708 and open the front cover.

A self-test will start and run for about 30 seconds. The display 
remains blank during this time.

Navigates back within a function menu.
Continuous 3 second press exits to the default screen.

Navigates upwards in the navigation list.
Navigates right within a function.

Navigates downwards in the navigation list.
Navigates left within a function.

Navigates to the right when within a function group.
Stores a value once configured.

ESC

E

39Configuration - Rosemount 5708V and 5708S



Reference Manual
00809-0100-4570, Rev DA

Configuration - Rosemount 5708V and 5708S
November 2017
6.2 Setting the polling address 
Setting the sensor address is mandatory when multiple sensors are connected over an RS-485- 
Multidrop (daisy chain). Set the addresses prior to use of the Rosemount 3DVision software.

2. After initialization, the version screen appears.

According to the factory default settings, after power initiation or 
restart, a screen prompts for configuration.

In the main menu, select Basic Settings.

3. Use the  /  keys to switch between the options.
Press  to select and continue with the settings or  to exit to 
the main screen.

4. When the startup process is complete, the following screen 
appears showing the current average distance measurement.
The top line displays the tag name. By default, this line is empty.
Select  to enter the main menu.

1. From the main screen, select the  key to enter the main menu.

2. In the main menu, use the  /  keys to scroll down to Polling 
Address. 

Select  to switch to the Polling Address configuration screen.

3. Use the  key to switch between the two digits. Use the  key to 
modify the value. 
The default polling address is 00. The polling address ranges from 
00 to 63.
Select  to store the modified address and  to exit to the 
main screen. 
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Section 7 Operation
Rosemount 3DVision/3DMultiVision overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .page 41
Installing the Rosemount 3DVision software  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .page 45
First-time running . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .page 54
Software navigation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .page 66
Advanced tools  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .page 91

7.1 Rosemount 3DVision/3DMultiVision overview
Rosemount™ 3DVision/3DMultiVision™ enables real-time assessment of bulk solids and powders, of any 
type or size, stored in storage vessels. The application periodically supplies information, providing the 
essential, real-time data required for critical decisions necessary for successful plant management.

Figure 7-1. Rosemount 3DMultiVision Output Example

The Rosemount 3DVision works in conjunction with Rosemount 5708 providing measurement data to a 
Windows™ based computer running the programs. The program continuously collects data from the 
monitored vessel and generates reports. The reports are used to increase operational efficiency, and 
provide the site managers with valuable real-time and historical information for effective decision 
making.
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Rosemount 3DMultiVision enables usage of a function on groups of vessels, even across multiple sites. 
Rosemount 3DMultiVision works in conjunction with the Rosemount 5708 to collect data from all 
monitored vessels in all sites and geographic regions, to combine and merge the data, and to generate 
and analyze various types of reports. 

Basically, both 3DVision and 3DMultiVision have the same capabilities, the one major difference is that 
the 3DMultiVision allows the user to view measurements from all vessels in one screen while in the 
3DVision, it is possible to view only one vessel at a time.

7.1.1 Server-client architecture
The Rosemount 3DVision/3DMultiVision software is comprised of two components: a server and a 
client. 

The Rosemount 3DVision Server runs on a designated computer and is connected directly or remotely to 
every Rosemount 5708 in a single, local site or in multiple remote sites. The data is stored on the server 
computer which generates the reports, collects and stores readings, and transfers the information to all 
connected Rosemount 3DVision clients. The server computer should be running and logging at all times. 

The Rosemount 3DVision Client is a graphical and interactive program, allowing the user to receive 
online measurement data, view a 3D visualization of the material stored in the vessels, add or remove 
sites, vessels, and Rosemount 5708, and manage alerts and reports. The Rosemount 3DVision Client 
supports several authorization levels of different privileges such as full-management authorized system 
administrators, technicians, and view-only operators.

7.1.2 Multi-client
The Rosemount 3DVision software is designed to work in a multi-client environment. Authorized users, 
connected to the same LAN or via external connections (WAN), have access to both real-time and 
historical data for all devices connected to the server.

Figure 7-2. Rosemount 3DVision Computer Topology

A. Remote 3DVision Client
B. Rosemount 3DVision Server Computer
C. Switch
D. Router
E. Internet
F. Local Client (LAN)

Local IP Address
192.168.1.100

Port 22222

Local IP Address
192.168.1.104

Local IP Address
192.168.1.105

Local IP Address
192.168.1.106

External Static IP
Address

212.235.113.24

INTERNET

A

B

C D

E

E

F
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Figure 7-3. Rosemount 3DVision Server Connection Example

A.120 Ω resistor
B. PLC / DCS / Display
C. 24 Vdc power supply
D. Rosemount 3DVision Server
E. RS-485 to USB converter

The Rosemount 3DVision Client application can connect to multiple Servers simultaneously. This feature 
enables the user to view data from multiple plants (without relation to geographical location) in a single 
screen. In addition, each Rosemount 3DVision Server can connect and supply information to an 
unlimited number of Clients. These features enable high flexibility in inventory management and 
amount of personnel reviewing the information.

When more than one client is logged as technician, only one can perform changes to the vessel or the 
configuration. If, for example, one user opened the Configuration Wizard, the second user that opens the 
wizard will get the following error message:

Figure 7-4. Setting Information Done by Another User

+ -
PS OUT

Display

+ -
PS OUT

Display

+ +- -
PS IN 4...20mA

+ -
RS-485 PS IN 4...20mA RS-485
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+ -
RS-485
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A

C D
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7.1.3 System requirements
Refer to Rosemount 5708 Quick Start Guide for the Software Installation requirements for the server and 
client.

7.1.4 Network considerations
When installing the Rosemount 3DVision Clients and Servers in a secured network or when it is needed 
to access the Rosemount 3DVision Server from an external connection (WAN – Wide Area Network) it is 
required to open TCP Ports in Firewalls, Routers or other devices or applications that might block such 
communication.

The required TCP Ports are:

 22220 – Control Port

 22221 – Used for data Connection

 22222 – Connection of Rosemount 3DVision Client to Server

 22223 – Logs Download Data Port

Additional TCP ports may be required when integrating the 3DVision to SCADA/DCS system using 
Modbus communication protocol. See Table 7-5 on page 72 Server options - SCADA Configuration, and 
Figure 7-33 on page 77.
44 Operation

http://www.emerson.com/documents/automation/Quick-Start-Guide-Rosemount-5708-Series-3D-Solids-Scanner-en-78202.pdf
http://www.emerson.com/documents/automation/Quick-Start-Guide-Rosemount-5708-Series-3D-Solids-Scanner-en-78202.pdf


Reference Manual 
00809-0100-4570, Rev DA

Operation
November 2017
7.2 Installing the Rosemount 3DVision software
After completing the recommended preparations listed in the prerequisite information section below, 
the Rosemount 3DVision program is ready to be installed.

7.2.1 Required information
Gather the following information related to each Rosemount 5708 connection prior to the software 
installation and Rosemount 5708 connections:

 Polling address of each Rosemount 5708 [00 – 63]

 Method of connection to the Rosemount 3DVision Server computer

 Vessel dimensions, filling points and Rosemount 5708 location

 Product information – Density (for mass calculation) and product name

For more information on various methods of connecting to the Rosemount 5708, refer to Section 4: 
Different connection methods.

7.2.2 Installation
For initial configuration, it is recommended to install both Rosemount 3DVision Server and Rosemount 
3DVision Client on the same computer. However, it is possible to install the Rosemount 3DVision Server 
and Client on separate computers and connect to them accordingly.

If you are using the Rosemount System Controller unit, skip to “Starting Rosemount 3DVision Server and 
Client” on page 51.

It is recommended to have an active Internet connection during the installation process, as updated 
versions of Microsoft .NET Framework and other components may exist.

Note
Do not install the server application on remote computers. It is not necessary and may result in slow 
operation.

To install the software:

1. Insert the USB flash drive into the USB port or download the installation file from the support page in 
Emerson website and execute the “Installer.exe” file. The installation wizard starts automatically and 
the Rosemount 3DVision setup wizard appears.

If the installation program does not start automatically, run “Installer.exe” from the flash drive.
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2. Select Install Rosemount 3DVision.

Note
If the computer where Rosemount 3DVision is being installed does not have Microsoft .NET Framework 
4.0 installed, the Rosemount 3DVision setup wizard automatically detects and prompts you to install 
this component. The installation file of the .NET Framework is provided in the flash drive supplied with 
the software and Rosemount System Controller.

3. Select your preferred language and OK to proceed. The installer's welcome box appears.

4. Select Cancel to stop the installation process and close the window.
OR
Select Next to proceed.
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5. Select Full install and select Next to install Rosemount 3DVision with all available features. The setup 
wizard completes the software installation.
OR
Select Custom install for remote client installations, and select Next to change the installation folder 
and select applications to install.

6. Select “I do not accept the ...” to cancel and exit the installation.
OR
Select “I accept the ...” and select Next to proceed with the installation.
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7. Select for which users the software should be available to:

 Install for all users to make the software available to all computer users.

 Install for current user to make the software available to the present user account only.

8. Select Next to confirm and proceed to the next step.
OR
Select Back to return to the previous step or select Cancel to stop the installation.

9. When the Custom Install option is selected:

a. Check the required options for the applications to be installed. You may choose to install Client 
app files only, Server app files only, or both.

Note
When installing a remote client, install the Client app files only.

b. Select Next to install the selected applications. 
OR
Select Back to return to the previous step or Cancel to stop the installation.
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c. If Server app files check-box was previously checked, select the installation method for the 
Rosemount 3DVision Server. The Server can be installed either as an Application (Process) or as a 
Service.

Note
When installing the Server as a Service, the server starts automatically when the OS starts and does not 
require the user to log in.

d. Select Next to choose the installation folder. 
OR
Select Back to return to the previous step or Cancel to stop the installation.

e. To change the default installation folder (if required), select Browse and specify the desired 
location for the installation.
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f. Select Next to proceed with the installation.

10. Select the Windows Start Menu folder where you want the program’s shortcuts to be added in the 
Choose Start Menu Folder window. You can also enter a name to create a new folder.

11. Select Install to proceed to install the software. Select Back to return to the previous step or Cancel 
to stop the installation.
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12. Select Finish to complete the installation and close the setup wizard.

Following a successful installation, the installation package creates a desktop shortcut in accordance 
with the applications installed (Rosemount 3DVision Server, Client, or both). A shortcut is also placed in 
the Startup folder in Program Files.

7.2.3 Starting Rosemount 3DVision Server and Client
When executing the Rosemount 3DVision Client for the first time, the system asks for details required to 
establish a connection to the Rosemount 3DVision Server. Following a successful connection, a new 
window appears to enter a user name and password. The default user level is Administrator, with the 
default user name: admin and password: admin.

1. Double-click the “Rosemount 3DVision Client” icon to start the client application. 

The application opens and the Rosemount 3DVision Server Connection window appears. On the first 
connection attempt, the Server Name and Server Address fields are empty and the relevant details 
must be entered. The connection information is kept for subsequent connections.
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a. In the Server Name field, enter your own description for the system managed by that server.

To activate the Server Name field, select Edit... Then the Server Configuration window appears.

b. In the Server Address field, enter the IP address of the computer running the Rosemount 3DVision 
Server:
 If both client and server applications are installed and running on the same computer, enter 

the computer local IP address, or type IP 127.0.0.1 or type “localhost”.

 If the client application is running on a remote computer, enter the IP address of the 
computer running the Rosemount 3DVision Server application.

c. In the Server Port field, verify that the server port is set to 22222.
d. Select OK.
e. Select Stay Signed In to automatically sign in on the next execution of the Rosemount 3DVision 

Client application.
f. Select Slow Connection to increase timers and timeouts of various commands in case of slow 

communication between the Rosemount 3DVision Server and the Rosemount 5708.
g. Select the Auto Reconnection after option to allow the Rosemount 3DVision Client to 

automatically reconnect (with a delay of 20 seconds) to the Rosemount 3DVision Server.

h. Select Connect. The application connects and the Login dialog box appears.

2. Enter User Name and Password. The default username and password are both "admin" (case 
sensitive).

Note
It is possible to sign out from the File menu under: File > Exit.
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3. Define the user names, passwords, and permission levels of the various user accounts prior to setting 
up projects in the system. At least one user account must have the administrator permission level. For 
further details, refer to “Users Management…” on page 74.

Note
To log in to the technician mode of the system, enter the technician mode user name and password. For 
further details, refer to “Switch User…” on page 74.

4. The server application may need some time to initialize communications with the Rosemount 5708 
and clients. Ensure the server icon appears on the task bar as shown.

The server should remain running. Manually running the server is required only if the computer is 
restarted and the server does not start automatically.

When installing the server, it is added to the Microsoft Windows Start Up files automatically.
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7.3 First-time running
The following steps are required to set a single vessel:

1. Creating a new project (see page 54).

2. Vessel configuration (see page 58).

3. Advanced parameters (see page 62).

4. Echo curve analysis (see page 62).

5. False echo mapping (see page 62).

6. Vessel properties configuration (see page 62).

These steps are basic and mandatory for the completion of a vessel commissioning.

For additional changes and modifications of the vessel and for the Rosemount 3DVision Software, refer 
to the various software menus starting on page 66.

7.3.1 Creating a new project
Following a successful login, the software automatically opens the last project. If no project exists, create 
a new project by selecting the New Project icon in the center of the screen or by selecting File > New… 
or by importing a saved project by selecting File > Import Project to Server….

Figure 7-5. New and Open Project Buttons
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To create a new project:

1. Select New Project. The Wizard window appears.

2. In the Name field, enter a name for the new project.

3. In the # Sites field, enter the number of sites the project should manage (each site may contain 
multiple vessels).

Figure 7-6.  Project Wizard - Site Name

4. Select Next.

Note
If you are running the Rosemount 3DVision application you can specify one site and one vessel only. An 
upgrade to the Rosemount 3DMultiVision version is required for configuring more than one site. Contact 
your local Emerson™ representative for purchasing a license key for upgrading to Rosemount 
3DMultiVision.

5. Enter the site name (limited to 16 characters), number of vessels in the site, and number of 
Rosemount 5708 in each vessel. Sites, vessels, and Rosemount 5708 can be edited later.

6. Select the connection type between the computer and the Rosemount 5708 in the site. 

RS-485, TCP/IP, GPRS and GPRS+SMS connections are available. The very basic connection method is 
RS-485. For further information on the connection methods, refer to “Communication methods” on 
page 91.
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7. Select the serial COM port for the server PC connection. 

Figure 7-7. Project Wizard - Site Connection

8. Select Finish. 

The new project is created and the vessels and sites appear on the main screen (Figure 7-8). 

Note
When a project includes more than a single site, each site should be defined individually with the number 
of vessels, the number of Rosemount 5708 units in each vessel, connection method, and serial COM 
port. Selecting Next switches to the next site. Repeat site configurations for each site. In the following 
example, a single site is defined.

Note
It is possible to change at any time the communication method, switch user to technician, select the 
device from the device selection drop-list appear above the 3D visualization (see Figure 7-15 on 
page 63), and go to the parameters tab, disconnect the Rosemount 5708 and set the new 
communication method and parameters. Select Save to save the project.

The project window is built according to the project hierarchy of Sites > Vessels > Scanners.
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Figure 7-8. Project Window

Multiple sites of the project may be defined. The defined sites appear and can be selected from the site 
selection bar. 

When selecting a site, its relevant information and configuration options appear in the main work area 
organized in two tabs: Vessels and Logs. Refer to “Main screen” on page 66 for display area descriptions.

Multiple vessels may be defined for each site. The vessels are represented by icons appearing on the 
vessel selection bar. When a site is selected, the corresponding vessels are displayed in the vessel 
selection bar. 

Selecting a vessel from the vessel selection bar displays various types of information and configuration 
options related to that vessel in the main work area. This information is organized in tabs: Overview, 
Logs, and Parameters. Right-clicking a vessel icon opens a menu with options related to that vessel.

Multiple devices may be defined under each vessel. A device can be selected and accessed from the 
device selection list (refer to “Main screen” on page 66).

Note
Selecting a Rosemount 5708 for configuration under a specific vessel can be done only by logging in as a 
user with Technician or Senior Technician privileges. 

Refer to “Users Management…” on page 74 for further details regarding user levels and authorizations.
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7.3.2 Vessel configuration
Following successful connection, it is required to configure the devices according to the physical 
installation and with information of the vessel’s dimensions and Rosemount 5708 mounting position.

The wizard is a 4-step procedure to configure the Rosemount 5708 to start working in the application 
installed, during the Configuration Wizard’s steps, there is a 3D visualization of the vessel representing 
the actions in each step.

To configure the vessel and devices

1. Select the vessel from the vessel selection bar (refer to “Main screen” on page 66). 

2. On the Device menu, select Device Configuration Wizard…. The Configuration Wizards opens 
(Figure 7-9 on page 59). 

3. Set the Measurement Units in use for Distance and for Temperature.

4. Select the proper shape for the vessel top from the Top Shape field. The options are: Flat, Cone, 
Dome, or Pyramid. Set the dimensions:

 For a Cone shape, set the height and the top diameter of the cone.

 For a Dome shape, set the height of the dome.

 For a Pyramid shape, set the top section height, width and length of the vessel top at the X and Y 
directions.

5. Select the proper shape for the vessel center from the Center Shape field. The options are: Cylinder or 
Cube or cylinder sector. Set the dimensions:

 For a cylinder shape, set the height and the diameter.

 For a cubic shape, set the height, width and length of the vessel according to the X and Y axis, 
respectively.

 For a cylinder sector, set both bottom and top shapes to flat, set the internal and external 
diameters, the sector angle (from 15 and up to 90 degrees) and set the sector height.

6. Select the proper shape for the vessel bottom section from the Bottom Shape field. The options are: 
Flat, Cone, Dome, Pyramid or Inverted Cone. Set the dimensions:

 For a Cone shape, set the height and the bottom diameter of the bottom section.

 For a Dome shape, set the dome height.

 For a pyramid shape, set the height, width and length of the vessel bottom section at the X and Y 
directions.

If the vessel shape is asymmetrical (for both cone and pyramid shapes), it is possible to set the 
bottom center as an offset from the entire shape center. The X Position and Y Position are the 
offset of the bottom section from the center.

For Inverted cone, set the height, bottom diameter and top diameter. The inverted cone can be 
configured only inside the center shape and only when it is set as a cylinder. Top diameter must be 
smaller than bottom diameter.

The 3D visualization in this step shows the complete vessel. When setting one of the shapes, the 
3D visualization will highlight the shape in red to indicate the part being configured at that 
moment.

7. Select Next.
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Figure 7-9. Configuration Wizard Step 1 - Vessel Dimensions

8. Set the Rosemount 5708 position on the silo top.

It is possible to set X and Y coordinates measured from the center of the vessel and set the offset of 
the Rosemount 5708 from the top of the vessel at the mounting position.

Z position is calculated automatically when the X and Y coordinates modified or there is a change to 
the offset from the top.

The angle is being calculated automatically when the X, Y coordinates changes, When Senior 
Technician user is logged in, there is an option to modify the angle manually by checking the Set 
device angle manually.

When entering this step, the 3D visualization is showing the silo from the top and indicating the 
Rosemount 5708 in the vessel and showing a red arrow indicating the direction of the device that 
should match the physical installation.
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Figure 7-10. Configuration Wizard Step 2 - Rosemount 5708 Positioning

9. Select Next.

10. Add the filling points on the top of the vessel. Up to nine filling points may be defined.

 Select Add and enter the X and Y coordinates in the Filling Points table and press Enter after 
every number entered. Filling points are marked as an inverted orange cone at the set position.

 Select Delete to remove the selected filling point.

 Select Clear to remove all filling points.

Figure 7-11. Configuration Wizard Step 3 - Device Position

11. Select Next.
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12. Configure the vessel full and empty calibration levels. Figure 7-12 shows the full and empty 
calibration fields to set.
It is possible to set the full and empty calibration as measured from the top (Distance) of the vessel or 
measured from the bottom (Level) of the vessel.

 Set the distance from the top of the vessel to set 100% (20 mA) (see Figure 7-12 on page 61) in 
the Full Calibration section. 
OR
Set the maximal material level in the Level (Bottom) field. Dead band is 1.64 ft (0.5 m) from the 
top of the Rosemount 5708 antenna case.

 Set the Empty Calibration by setting the level or the distance from the top of the vessel to set the 
0% (4mA) (see Figure 7-12). Default value is set to the bottom of the vessel.

 Select the Default button to set the full and empty calibration levels to default values.

 Select View Table to open a window showing a summary table of each Rosemount 5708 in the 
vessel and the actual full and empty calibration levels configured, see Figure 7-13 on page 61.

13. Select Finish.

Figure 7-12. Configuration Wizard Step 4 - Full and Empty Calibration Levels

Figure 7-13. Full and Empty Calibration Levels Summary Table

14. When the configuration wizard settings are completed, select the Finish button. The parameters will 
be uploaded to all devices in the vessel.
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7.3.3 Advanced parameters
It is recommended to adjust some of the advanced parameters.

Open the advanced parameter window (select Device > Advanced Parameters… or press F3) in order to 
set general parameters, such as Max Capacity, Filling and Emptying Rates, Material Slope and Damping 
Time. Other parameters may be configured and fine adjustments can be done at a later stage. Refer to 
“Advanced parameters” on page 96 for detailed instructions and descriptions.

7.3.4 Echo curve analysis
When first configuring the vessel, it is recommended to perform Echo Curve Analysis, see chapter 
“Performing Echo Curve Analysis” on page 109.

View the Echo Curve Analysis results in echo curve viewer. For additional information, see chapter 
“Viewing Echo Curve Analysis” on page 110.

Using the Echo Curve Analysis it is possible to determine if any of the advanced parameters need 
additional changes.

7.3.5 False echo mapping
Using the Echo Curve Analysis result, it is possible to determine if false echo mapping actions are 
needed. For additional information see “False Echo Mapping” on page 112.

7.3.6 Vessel properties configuration
The example below shows how to configure a single site with a single vessel and two Rosemount 5708S.

Note
In order to configure a vessel with more than one Rosemount 5708, all devices must have the same 
model number (e.g. Rosemount 5708S). Contact your local Emerson representative to purchase a 
license key for upgrading options.

To configure vessel properties:

1. Select the vessel from the vessel selection bar (refer to “Main screen” on page 66).

2. Right-click the vessel and select Property… from the drop-down menu. The Edit Base Properties 
window opens (Figure 7-14). 

3. Enter the vessel name and description. Select OK.

Figure 7-14. Edit Base Properties Window

4. Double-click the vessel in the vessel selection bar to open the vessel measurements and details in the 
main work area (Figure 7-15). The Overview tab shows how many devices are set for this vessel and 
their connection status.
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Note
If the selected vessel contains more than one device and the user has technician privileges, a device 
selection list appears (see Figure 7-15). Select the required device for configuration from the list.

Figure 7-15. Rosemount 3DMultiVision Vessel Overview Tab

5. Select the Parameters tab to configure the Rosemount 5708 parameters (Figure 7-16 on page 64). 

Note
Rosemount 5708 parameters can be modified only in technician mode.
For further information on the connection methods, refer to “Communication methods” on page 91.
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Figure 7-16. Rosemount 5708 Parameters Tab

6. Select the Devices tab to set connection type, serial COM port, and polling address.

Figure 7-17. Rosemount 3DMultiVision Vessel Devices Tab

7. Set Connection Type (the unsupported types are visible but not selectable). 

Note
Connection type is enabled for editing only when the Rosemount 5708 is disconnected. 

For further information on the connection methods, refer to “Communication methods” on page 91.

8. Set Serial COM Port. 

9. Set Polling Addresses.
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10. Configure each Rosemount 5708 set for the vessel by selecting them from the device selection list 
and entering their communication parameters.

11. Once all devices are configured, connect to all the devices in the vessel by right-clicking the vessel 
name and selecting the Connect option from the drop-down menu. 

12. When a connection is established, select the site from the site selection bar (as shown to the right). 
The vessel profile screen appears with the results of the scanned measurements.

13. To view a 3-dimensional profile, right-click on a vessel in the main work area and select Show 3D 
visualization from the drop-down menu. The profile window opens (Figure 7-18).

Figure 7-18. Product 3-Dimensional Profile

Note
When connecting to the Rosemount 5708S, the 3D visualization of the product in the vessel is available 
by double-clicking the vessel.

For further information on the 3D visualization, refer to “3D visualization” on page 128.
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7.4 Software navigation
This chapter provides an overview of the various toolbars, menus, and projects.

7.4.1 Project overview
The Rosemount 3DMultiVision software allows for defining different projects. Each project is organized 
in the following hierarchical structure:

 Top Level: The project

 Second Level: A list of sites

 Third Level: A list of vessels located in the site

 Fourth Level: A list of devices associated with each vessel

For example, a single project may include multiple sites (or multiple groups of vessels), where each 
site/group may contain multiple vessels, with a minimum of one Rosemount 5708 per vessel.

7.4.2 Main screen
Figure 7-19 displays the main screen areas followed by their descriptions. 

Figure 7-19. Main Screen

A. Main menu bar: Includes the main menus: File, Communication, Edit, Device, View, Tools, and Help.

B. Project toolbar: Includes various tools for project management and operations including project opening and saving, 
connection to sites, and data loading.

C. Site selection bar: A project allows multi-site management, where each site may include multiple vessels. In the site 
selection bar, a site can be selected for monitoring and operations.

D. Vessel selection bar: Lists all vessels included in the selected site. In the vessel selection bar, a vessel can be selected for 
monitoring and various operations.

E. Control tabs: Includes tabs related to the selected item (site, vessel, or Rosemount 5708). Each selected tab is displayed in 
the main work area.

F. Main work area: Provides graphical and textual information and properties, and different modification and control 
options related to the selected item (site, vessel, or Rosemount 5708) and tab.

G. Status bar: Displays actual information related to different operations performed, such as downloading data and 
connection.

A

B

D

E

F

G

C

66 Operation



Reference Manual 
00809-0100-4570, Rev DA

Operation
November 2017
7.4.3 Main menu bar
The Rosemount 3DVision Client main menu bar accesses the main menu options.

Figure 7-20. Main Menu Bar

File menu
The File menu includes the following options:

Figure 7-21. File Menu

Table 7-1.  File Menu

Note
The Import and Export functions are for maintenance. They enable downloading projects to a local 
computer for modifications and Software upgrades, and then uploading the modified projects back to 
the server.

Option Description

New... Starts a new, empty project.

Open... Opens an existing project.

Save Project Saves the current project.

Save Project As... Saves current project as a different name.

Export Project from Server… Exports a project in XML format.

Import Project to Server… Imports a project in XML format.

Delete Project Deletes a project from the server. A window opens with a list of all projects 
stored in the server and the desired project is selected.

Browse to Local Folder… Allows browsing the software installation folder.

Exit Closes the application.
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Note
Projects can only be deleted if there is at least one project remaining. The current project cannot be 
deleted.

Communication menu
The available options in the Communication menu change in accordance with the selected item. If a 
vessel is selected, it corresponds to a vessel connection. If a Rosemount 5708 is selected, it displays 
Rosemount 5708 related commands, e.g. Connect & Disconnect. 

The following options are available when a vessel is selected:

Figure 7-22. Communication Menu

Table 7-2.  Communication Menu

Option Description

Connect All Connect to all the devices in the selected site.

Disconnect All Disconnect from all the devices in the selected site.

Load from Vessels Download all data from all vessels.

Connect Vessel Connect to all devices in the selected vessel.

Disconnect Vessel Disconnect all devices in the selected vessel.

Load from Vessel Download all data from all devices in the selected vessel.
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Edit menu
The Edit menu includes the following options:

Figure 7-23. Edit Menu

Table 7-3.  Edit Menu

Option Description

Add ► Add sites, vessels, or devices depending on the level selected in 
the project pane. 

Site On the site level it adds sites or vessels.

Vessel On the vessel level it adds devices.

Scanner On the device level it is disabled.

Delete ► Delete sites, vessels, or devices depending on the level selected 
in the project pane.

Site On the site level it deletes sites.

Vessel On the vessel level it deletes vessels.

Scanner On the device level it deletes devices.

Properties ► Set a name and description to a site or a vessel

Site On the site level define the name and description of the site.

Vessel On the vessel level define the name and description of the vessel.

Vessel graphic figures Additional option (only available when a vessel is selected): Add 
text labels on the 3D visualization (X, Y, and Z coordinates are 
referenced to the center axis located at the bottom center of the 
vessel).

Edit Project... An interface option to rearrange the vessels and sites per 
requirements.

Save Selected Vessel Configuration As... This operation saves the selected vessel configuration into an 
XML file for maintenance and support issues.

Load Vessel Configuration OnLine... This operation uploads a saved XML file with the vessel
configuration into the project that is running online.

OffLine Configuration ► When in Offline mode there are options to work on existing 
project.

Manual Load to Selected Vessel... This operation loads parameters manually when the software is 
offline and not connected to devices.

Cancel Manual Load from All Vessels This operations cancels manual load from all the vessels in the 
project.

Browse to Vessel AutoSaved File 
Folder...

This operation opens a window within the folder with all the 
saved configuration XML files.
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Figure 7-24. Edit Project Option

Figure 7-25. Vessel Graphic Figures

Figure 7-26. Example of Adding a Text Label to the 3D visualization
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Device menu
The device menu includes the following options:

Figure 7-27. Device Menu

Table 7-4.  Device Menu

Option Shortcut Description

Device Configuration Wizard... F4 Opens the configuration wizard for the selected vessel, see 
“Vessel configuration” on page 58.

Advanced Parameters... F3 For additional info, refer to “Advanced parameters” on 
page 96.

Device Current Simulation 
Settings…

F6 For additional info, refer to “Device current simulation 
settings” on page 101.

Device Output Current… F8 For additional information, refer to “Device output current” 
on page 102.

Device Output Settings… F7 For complete information about all functions under the 
Output Settings window, refer to “Device output settings” on 
page 103.

Echo Curve Analysis… Ctrl+Z For complete information about all functions under the 
Output Settings window, refer to “Echo Curve Analysis” on 
page 109.

Echo Curve Analyze Viewer… Ctrl+V For complete information about all functions under the 
Output Settings window, refer to “Viewing Echo Curve 
Analysis” on page 110.

Device False Echo Mapping… N/A For complete information about all functions under the 
Output Settings window, refer to “False Echo Mapping” on 
page 112.

Devices Activations… N/A Allows different types of Resets, Update Firmware and to test 
communication quality. For complete information about all 
functions under the Output Settings window, refer to “Device 
activations” on page 114.

Update Model... N/A Allows a Rosemount 5708L or 5708V to be upgraded to a 
Rosemount 5708V or 5708S.
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Note
Some of the options allow changes only if the user is a Technician or a Senior Technician. Refer to “Users 
Management…” on page 74 for additional information. Viewer has no option to do any changes under 
this menu, Administrator can do only some of the actions.

Tools menu
The Tools menu offers useful tools such as reporting and administration tools, material configuration, 
Server options, user management and Demo mode.

Figure 7-28. Tools Menu

Table 7-5.  Tools Menu

Option Description

Reports ► Report files are created and stored in Excel worksheet format and can be 
opened, viewed, and manipulated using Excel.

Note
To open and view report files in Excel® format, Microsoft Excel must be 
installed on the computer.

Reports Definition 
Wizard... (F9)

Opens a wizard to set, edit and generate reports.
“Reports Wizard” on page 116.

Export Present Project 
Reports from Server

Opens a date picker to select the From and To dates for the project reports. 
Select OK to retrieve the list of corresponding report files from the server 
(Figure 7-29). Select the required reports from the list. Click Select to browse 
to a folder to store the selected report.

Browse to selected project 
report folder

Opens a file browse window in the project report files location on the local 
hard drive. Available only if the Client is running on the same computer as 
the server.

Show last generated 
report

Opens the last generated report in Excel. Available only if the Client is 
running on the same computer as the server. See Figure 7-29. 
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Generate report for 
selected vessel (logs data) 
►

Select logs directory 
from local folder…

Browse to local folder to retrieve saved reports

Download from 
server

Select time and date of the required information. The generated file is a .pdf 
and will be saved at a selected location.

Hardware Inventory 
Table…

Displays a special report including details for all project devices. For more 
details, refer to “Hardware inventory table” on page 125.

Measurement Summary 
Table…

Displays a special report of vessel storage measurements for all project 
vessels. For more details, refer to “Measurement summary table” on 
page 125.

Events Log Viewer... Displays a list of events tracking of changes in the project, 

Material Configuration… Opens the Material Configuration window for defining new material types 
and color and for setting bulk density for mass calculation. This data is 
displayed in the vessel images. For further details, refer to “Material 
configuration” on page 127.

Server Options... Summary: Opens a window with a summary of the server information. See 
Figure 7-30.

Configuration: Allows setting the Server's Local folder to save all files.

Active TCP Connections: Retrieves and displays a list of all active TCP 
connections on Server computer and contains a list of all existing 
connections to the server. Each connection displayed includes the local port, 
remote port, TCP/IP address, and status. See Figure 7-31. 

Active TCP Listeners: Retrieves and displays a list of all existing TCP ports 
listeners on the server computer. See Figure 7-32.

Scada Configuration: Allows SCADA systems to be integrated to the server. 
Opens a window for activating integration support and specifying up to four 
TCP listening ports, allowing up to 4 different SCADA systems to retrieve 
information from the server. The communication type is Modbus RTU 
encapsulated in TCP/IP packets or Modbus TCP. In addition, a folder path can 
be set to store a file containing the 3D visualization to be popped up from 
the SCADA system. See Figure 7-33.

License Key: Upgrade from the single-vessel Rosemount 3DVision software 
license to the Rosemount 3DMultiVision software license by entering a new 
license key. Also entering license codes for Center of Gravity and Output by 
Sections activations. For a detailed description, refer to “Upgrading to 
Rosemount 3DMultiVision” on page 132.

Paste the License key you received into the field and select Apply. The 
Rosemount 3DVision Client title bar switches from Rosemount 3DVision to 
Rosemount 3DMultiVision, if the key is correct. See Figure 7-35.

Server Options...
(Continued)

The Don’t remind check-box on Figure 7-34 is for not getting the 
notification on the top window screen part that there is a remaining X days 
until the free 30-days trial Rosemount 3DMultiVision license is over.

Logged Clients: Shows a list of clients currently connected to the 
Rosemount 3DVision Server. See Figure 7-35.

Connect to Server… Connects the client to a server (if not already connected), or disconnects the 
current connection and connects to a different server. For further details 
regarding server connection, refer to “First-time running” on page 54.

Sign Out Cancels the 'Stay Signed In' option previously selected when the Rosemount 
3DVision Client was executed.

Option Description
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Switch User… Logs out the current user and logs in as a different user. This function opens a 
window requesting the user name and password.

Note
Each user account has its own defined permission level. If you switch to a 
user account with a lower permission level, you will be more limited in the 
actions you can perform.

Users Management… Opens the Users dialog box displaying a list of all the user accounts defined 
on the server and their permission levels. For further details regarding user 
levels and authorizations, refer to “User management” on page 126. This 
option is available to users with Administrators privileges. See Figure 7-36.

The Users dialog box enables adding, removing, and changing properties of 
users.
 Users Authorization is Enabled: Un-checking this field will allow 

opening the Client without the need to enter user name and password.

 Add: Select to add a new user. A dialog box opens requesting a name, 
password, and permission level for the new user.

 Remove: Select the user account you want to delete, and then select 
Remove.

 Properties: Select a user from the list and select Properties to change 
their properties. A dialog box opens enabling the user to change the 
name, password, and permission level for the selected user.

 Close: Select to accept the changes and close the Users dialog box.

Client Options... Site - Vessel: See Figure 7-37.

 Site view manual: Allows multiple vessels in a single display without the 
need to scroll the window.

 Vessel width limits: Defines the minimum and maximum width 
dimensions of the vessel in site view. Measured in pixels. When the 
window is stretched or reduced, the size of the vessel will change 
between these values.

 Vessel height limits: Defines the minimum and maximum heights of the 
vessel in site view.

 Group by name/material/site name: Defined in parallel to vessel limit 
definition, to give full flexibility in different types of layouts and switching 
between layouts.

 Reduced vessel display: When reducing the size of window, the vessel 
size in site view will be smaller up to the limit of minimum size configured 
in this window. Values on the right side will disappear and only the first in 
the list will appear above the vessel drawing.

 Enlarge text area width in vessel display: If checked, it will enlarge the 
text above the vessel's image. By default, it is not checked and the text 
above the vessel's view will be small.

 Enlarge Sites tool bar to maximum: When working with multiple sites, 
if checked, it will squeeze all the sites in the menu bar as much as possible, 
else it will give the option to scroll left and right for sites display.

 Show vessels chart lines according to site: In the vessel's logs tab, all 
the logs of the vessels in the site (group) that the vessel is related to will 
be shown. For example, if we have three sites, and in one of the sites we 
have 7 vessels, selecting this option, all the seven related trends in one log 
chart will be displayed.

Option Description
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Figure 7-29. Report Files Selection

Client Options...
(Continued)

Project: See Figure 7-38.

 Auto save project on vessel change: If checked, it will automatically save 
all changes made to the project.

 Show save project warning on vessel change: if checked, for every 
change done in the project, it will give a pop up window to alert the user 
that a change is planned, and the user must save in order to continue. 

 Logo Image File...: The user can add a (company) logo/image on the top 
right corner of the Rosemount 3DVision main screen. 

Change Language: See Figure 7-39. Enables changing the software's 
language.

Server Connection Mode: See Figure 7-40. Enables the user to choose 
between single server connection or multiple servers connection from a 
client's Rosemount 3DVision. 

Translate Application: Allows the user to translate the Rosemount 3DVision 
to any language and send the translation file to the manufacturer to embed in 
future versions.

Sites/Vessels Filtering: See Figure 7-41. In a complex project with multiple 
sites and vessels, the software allows an option of viewing a partial set of 
selected vessels and sites only, per the preference of the user.

Refresh Display (F5) This option refreshes the screen display in the case of communication 
problems.

Demo ► Activates the software in Demo mode. This option includes selecting a demo 
site, performing a simulated operation of the sites, various components, and 
creating logs. For further details, refer to “Demo mode” on page 126.

Option Description
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Figure 7-30. Server Options... - Summary

Figure 7-31. Server Options... - Active TCP Connections
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Figure 7-32. Server Options... - Active TCP Listeners

Figure 7-33. Server Options... - Scada Configuration

Figure 7-34. Server Options... - License Key
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Figure 7-35. Server Options - Logged In Clients

Figure 7-36. Users Management Dialog Box
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Figure 7-37. Client Configuration Window - Site - Vessel
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Figure 7-38. Client Configuration - Project

Figure 7-39. Client Configuration - Change Language
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Figure 7-40. Client Configuration - Server Connection Mode

Figure 7-41. Client Options / Sites - Vessels Filtering
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Help menu
The Help menu includes a link to the Rosemount 5708 Quick Start Guide and to this reference manual.

The About option opens a window with version details, Emerson support number, and a link to the 
Emerson website.

Figure 7-42. Help Menu
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7.4.4 Project toolbar

Figure 7-43. Project Toolbar

Function Description

Level/Distance Data Toggles the measurement type displayed in the vessel by either Level or 
Distance.

Level refers to the level of material measured from the bottom of the 
silo. Distance refers to the distance of the material from the Rosemount 
5708.

The selection applies for measurements in all viewing panes, at all view 
levels, for the corresponding values (min/max/average). 

Connect Vessel Connects the selected Vessel to the application.

Disconnect Vessel Disconnects the selected Vessel from the application.

Load from Vessel
Downloads all measurements from the selected vessel to the 
application. All data is automatically downloaded from all devices to the 
server.

Wizard This button is a shortcut for opening the Wizard. 

Echo Curve A shortcut to open the Echo Curve Analysis window, same as clicking 
Device > Echo Curve Analysis or by clicking Ctrl-Z

VDC Stands for Vessel Data Collector - a tool to help users collect all relevant 
information from the vessel and to send it to the factory.
Need to add another chapter showing the windows and options on the 
VDC.
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Sort By Organizes the vessels by group.
 All: Arrange by the numbering order as defined in the project.

 Material: Displays the vessels ordered alphabetically by material.

 Name: Displays the vessels ordered alphabetically by name.

 All Same Size: Displays all vessels as the same size in one window 
(without scrolling).

 Manual 4x4, 5x5 and 6x4: Displays the vessels arranged in a matrix 
with the selected dimensions.

 Manual: Displays the vessels arranged in a matrix with dimensions as 
defined in Tools > Client Options > Site - Vessel > Site View Manual 
Layout.

When selecting a sorting option other than All, the site display changes 
and shows the vessels in groups arranged according to the sorting 
criteria, as shown in the following image:

The Manual sorting options display the vessels with different sizes in 
accordance with the selected option. Smaller sizes may be more 
convenient when managing a large site. For example, selecting Manual 
4x4 displays the vessels as follows:

Connection status Indicates the client connection to the server. See “Alert types” on 
page 152.

Sort By: Name view

Sort By Manual
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7.4.5 Vessel selection behavior
Vessels are displayed in blocks in the main work area. Each vessel is represented by a rectangle with the 
following information:

 The vessel image containing the material stored using the selected material color at its current 
level/distance.

 Stored material name and device model.

 Empty and full calibration levels represented by orange and red lines respectively.

 Level measurements: Average level/distance, maximum level and minimum level/distance, in the 
configured measurement units, and volume in percentage. Additional information can be added by 
right clicking the vessel. For more information, refer to “Parameters and alerts” on page 152.

 A connection status indicator: Note that in the case of a connection failure, the indicator and the entire 
background of the rectangle becomes red.

Figure 7-44. Main Work Area
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Double-clicking a vessel icon in the vessel selection bar replaces the display with a detailed vessel pane in 
the main work area, with the Overview tab selected.

Figure 7-45. Detailed Vessel Pane when Double-clicking a Vessel Icon

A. Double-click a vessel icon to view a detailed vessel pane in the main work area
B. Detailed vessel pane

Right-clicking the vessel icon opens a drop-down menu with the following features:

 Connect: Connects to the devices on the vessel.

 Disconnect: Disconnects communication between the server and the Rosemount 5708.

 Load from Vessel: Downloads all parameters from the devices connected to the software.

 Generate report (logs data) - Download from server... : Opens the Search Log window for selecting 
a report date and time. Then it downloads the corresponding historical data from the server and opens 
a Save As dialog box to save the report file. 

- The report file is created in PDF format and includes the date, time, project, and vessel details, and 
volume/mass and alert parameters for the selected date and time.

- The report also includes a 3D visualization of the corresponding vessel.

 Generate report (logs data) - From local folder...: Opens a Browse for Folder dialog box to browse to 
the folder where the related data is stored. Creates a report as described above, but per data stored 
locally.

 Property...: Opens the Parameters Definition window allowing the user to select the visible material 
properties in the representing rectangle and the alert types to be used for that vessel. For further 
details regarding alerts, see “3D visualization” on page 128.

A

B
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Figure 7-46. Vessel Selection

A. Right-click the vessel icon to open a drop-down menu
B. Click a vessel in the main work area to select the vessel

A single click selects the vessel. The selected rectangle becomes outlined with a yellow frame, and the 
corresponding vessel icon in the vessel selection bar is selected.

When right-clicking a selected vessel in site view, the drop-down menu opens with the following added 
options:

 Show 3D Profile...: Opens a 3D visualization window.

 Connect: Connects communication between the selected vessel Rosemount 5708 and the server.

 Disconnect: Disconnects communication between the selected vessel Rosemount 5708 and the 
server.

 Load from Vessel: Loads data from the vessel Rosemount 5708 and updates the displayed status and 
parameters.

 Device Configuration Wizard...: Opens the Configuration Wizard for the selected vessel.

 Advanced Parameters…: Opens the Advanced Parameters window.

 Echo Curve Analysis…: Opens the Echo Curve Analysis window.

 False Echo Mapping…: Opens the False Echo Mapping window.

 Edit: Allows for adding a new device to the selected vessel or deleting the entire vessel.

 Generate report (logs data) – Download from server...: Opens the Search Log window for selecting 
a report date and time. It then downloads the corresponding historical data from the server and opens 
a Save As dialog box to save the report file.

- The report file is created in PDF format and includes the date, time, project and vessel details, and 
volume/mass and alert parameters for the selected date and time.

- The report also includes a 3D visualization of the corresponding vessel.

A

B
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 Generate report (logs data) - From local folder...: Opens a Browse for Folder dialog box to browse to 
the folder where the related data is stored. Creates a report as described above, but per data stored 
locally.

 Material Selection...: Opens the Material Configuration window allowing the user to select a stored 
material for the specific vessel.

 Properties...: Opens the Parameters Definition window allowing the user to select the visible material 
properties in the representing rectangle and the alert types to be used for that vessel. For further 
details regarding alerts, refer to “Parameters and alerts” on page 152.

Figure 7-47. Right-clicking a Selected Vessel in Site View

A. Right-click a selected vessel to open a drop-down menu

A
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7.4.6 Vessel pane
The Vessel pane provides vessel monitoring options and basic vessel operations (Figure 7-48). This pane 
opens in the main work area when a vessel is selected from the vessel selection bar.

Figure 7-48. Vessel Pane

A. Vessel selected from the vessel selection bar
B. Device drop-down list

Overview tab
Selecting the Overview tab displays two panes in the main work area.

The left pane includes the vessel connection information, alerts, measurements, and indications related 
to the selected vessel:

 Vessel name, connection status of the vessel, and selected devices

 Alerts, if they exist

 Device names, versions, and communication details

 Average, Minimum and Maximum Level/Distance

 Volume (%), Volume in the selected units and max scale

 Mass (if density is defined) and max scale

 Temperature

 SNR

 Rosemount 5708 Output Current

 A graphical representation of the vessel, including the vessel shape, maximum and minimum levels, 
and connection status indicator.

Material button: Opens the Material Configuration window which allows for managing the materials in 
the vessel. The material can be chosen out of a pre-defined list of materials and their representing colors. 

A

B
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When a device is selected from the device list (when the user is with technician privileges), the following 
information is also displayed:

 Scanner Name

 Connection Type

 COM Port 

 Polling Address

 S/N – electronic card serial number

 Hardware Version

 Firmware Version

 Device model

Logs tab
The Logs tab provides a chart representation of historical measurements data and allows for different 
manipulations of chart inspection. For further details, refer to “Log views” on page 146.

Parameters tab
Selecting the Parameters tab, the following parameters are displayed in the main work area:

 Vessel SCADA ID

 Scanner

 Poll Addr

 S/N

 Hardware

 Firmware

 Device Type

 Avg. Level

 Max. Level

 Min. Level

 Volume

 Temperature

 SNR

 Current Output (mA)

Devices Tab
Selecting the Devices tab displays and allows modifying the communication settings. In addition, it show 
the Rosemount 5708 Polling Address, or a list of device polling addresses for a vessel with multiple 
Rosemount 5708 in a system configuration vessel. Option modifications are not allowed when devices 
are connected. Click Disconnect next to the device or at the toolbar and modify communication as 
needed. Multi-scanner vessels may include Rosemount 5708 units with different polling addresses that 
are not in series.

For a detailed explanation regarding the various ways of connect to a Rosemount 5708, 
“Communication methods” on page 91.
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Device parameters
When a device is selected from the device drop-down list (see Figure 7-48), the device parameters are 
displayed. When mounting more than one Rosemount 5708 in one vessel, select the device from the 
drop-down list and configure its parameters in the tab of that specific Rosemount 5708.

This operation allows viewing the Rosemount 5708 specific measurements and logs. This selection is 
useful when a vessel with multiple Rosemount 5708 in a system is connected.

7.5 Advanced tools
The following sub-sections describe several useful tools for configuration, system 
administration, and reports handling.

7.5.1 Communication methods
The Rosemount 3DVision Server allows various connection methods: HART®, RS-485, TCP/IP, GPRS, 
GPRS+SMS and Smart GPRS, this chapter will explain each of the methods.

Communication method can be changed at any time when entering the Rosemount 3DVision Client 
using Technician rights, to create technician user, refer to “User management” on page 126.

HART
HART communication to the Rosemount 5708 requires a HART compatible modem. It can be either a 
USB or a Serial RS-232 modem connected to the computer running the application, when the COM Port 
is known. Note that only one Rosemount 5708 can be connected to the HART modem. For additional 
information, refer to Section 4: Electrical Installation.

To set the HART Communication:

 Select the COM Port in which the HART modem is connected to and select Finish.

Note
The Rosemount 5708 is not fully HART complaint and cannot be configured with HART hand held device.

Figure 7-49. HART Connection Type
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RS-485
RS-485 communication requires a converter from RS-485 to USB or RS-232 to be connected to an 
available COM Port (or USB port) in the computer.

To set the RS-485 communication:

Select the COM Port which the RS-485 converter is connected to and select Finish.

Figure 7-50. RS-485 Connection Type

TCP/IP
The TCP/IP option allows converting and transferring the RS-485 data over TCP/IP using a compatible 
converter. When establishing a connection to the TCP/IP converter, the local IP address and the TCP port 
values must be set as defined in the converter.

To set the TCP/IP connection:

TCP/IP: The Rosemount 5708 is connected via a TCP/IP network to an RS-485 connection.

1. Set the site name in the phonebook.

2. In the Server IP Address box, type the Server IP address and the Server IP port number in the right 
fields. 

 Server IP is the device converting RS-485 to TCP/IP.

 IP Port is the TCP Port assigned to in the TCP/IP converter.

3. Select Finish.
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Figure 7-51. TCP/IP Connection Type

GPRS
The GPRS option allows IP connection to a remote Rosemount LinkPro with GPRS enabled. When 
selecting this option, a TCP port must be opened in the local network and to be forwarded to the 
computer running the Rosemount 3DVision. 

After selecting Connect, an SMS message should be sent manually to the Rosemount LinkPro in the 
following format:

Note
A comma must end the SMS message.

For example:

GPRS: The Rosemount 5708 is connected through the Internet over GPRS using Rosemount LinkPro.

1. Enter the local IP port number assigned to the computer.

2. Select Finish.

3. Before selecting the connect button, send an SMS message from a mobile phone to the Rosemount 
5708 to initiate the connection.

Note
Prior to connecting via GPRS, the local IP port must be configured in the router, using the Port 
Forwarding configuration. Contact your local IT administrator to do the router configuration.

CALLAPM,[external IP address],[TCP Port],[APN], 

CALLAPM,82.123.25.102,7024,Internet,
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Figure 7-52. GPRS Connection Type

GPRS + SMS
The Rosemount 5708 is connected via the InternetInternet using Rosemount LinkPro. This connection 
uses SMS messages sent from another Rosemount LinkPro with a SIM card capable of sending SMS 
messages that is connected to a serial COM Port on the same computer running the Rosemount 
3DVision Server.

1. Select the serial COM port of the Rosemount LinkPro connected to the computer.

2. Select or set site name.

3. Set phone number of the Rosemount LinkPro connected to the Rosemount 5708.

4. Set the computer local IP port.

5. Set the external IP address (usually the router IP address).

6. Set the APN of the Rosemount LinkPro connected to the Rosemount 5708.

7. Select Finish.
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Figure 7-53. GPRS + SMS Connection Type

Smart GPRS
Same settings as GPRS + SMS configuration with a difference of the SMS Server.

The SMS Server is a small application sold separately by Emerson and designed for GPRS connections 
from different computers using one static source for sending the SMS messages to initiate the GPRS 
communication.

The additional two fields to set are the computer IP Address running the SMS Server and the TCP Port in 
use, by default the port is 9669.

This option is available only for Senior Technician users.
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Figure 7-54. Smart GPRS Connection Type

7.5.2 Advanced parameters
Algorithm parameters can be adjusted in the Advanced Parameters window. The various fields can be 
downloaded or uploaded from/to the Rosemount 5708. Any changed parameter, if not uploaded to the 
device, can be discarded using the Close button at the bottom, see Figure 7-55 on page 97. Emerson 
recommends consulting an Emerson official distributor or Emerson Technical Support before changing 
any of the parameters.

The Advanced Parameters window is available when Technician and Senior Technician users are logged 
on. Technician users have limited access to the parameters.

To open the Advanced Parameters window:

Select Device > Advanced Parameters or press F3.
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Figure 7-55. Advanced Parameters

A. Device drop-down list
B. Parameters tabs: 

- Vessel
- Advanced
- Beams Activation

C. Download all
D. Upload All
E. Summary
F. Close

Device drop-down list: This list will hold all devices in the vessel, it is possible to select any of the 
devices.

Parameters tabs: Switch between the Vessel, Advanced Parameters, and Beams Activation tabs for 
various functions.

Download all: Download all configured parameters from the devices to the software. If any changes 
happen beforehand, it will be seen in parameters changing accordingly in the window.

Upload all: The first five parameters must be the same, when changing one and selecting Upload all it 
will upload all five parameters to all the devices connected in the vessel.

Summary: Open a summary table in a separate window to show all devices and their parameters in a 
single table. See Figure 7-56 on page 97.

Close: Close the Advance Parameters window.

Figure 7-56. Advanced Parameters Summary Table

A

B

C D E F
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Vessel tab

Figure 7-57. Advanced Parameters - Vessel Tab

Output Damping Time: Sets the history damp window time of the Rosemount 5708. This parameter 
increases stability and improves the SNR. Default value: 300 seconds, minimum value: 60 seconds. It is 
recommended increasing this value when configuring a multiple Rosemount 5708 in a system.

Steepest Material Slope: Set the maximum material slope. The Rosemount 5708 verifies all echoes for 
not exceeding the slope. Default: 35°. Recommended settings: between 30° to 45°.

Max. Capacity [mass]: The total capacity of material within the vessel. Default: 100

Max. Emptying Rate [mass/hour]: The maximum emptying rate. Default: 10

Max. Filling Rate [mass/hour]: The maximum filling rate. Default: 10

Note
It is recommended to set the maximum capacity and Filling/Emptying rates according to the actual 
process in the vessel.
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Advanced tab

Figure 7-58. Advanced Parameters - Advanced Tab

Angle Adapter: In case the antennas are installed in an angle with a Rosemount angle adapter or with 
other mechanical solution it is required to adjust the angle in the configuration. By default, the angle is 
set to 0°, maximal value is 30°.

Side Margins [m/ft]: Allows tolerance in echo recognition to vessel walls (see figure). Used for creating a 
tolerance in case of unknown vessel width/diameter, and when a tolerance is required for detecting 
points on the vessel walls

Echo within the tolerance/margin range is transformed to the vessel wall on the X-Y plane and will not be 
eliminated in calculation. Default: 1m (3.28 ft.).

Bottom Margins [m/ft]: Allows adding a tolerance in echo recognition from the bottom shape (see 
figure). This feature is used for creating a tolerance in the case of unknown vessel dimensions, and when 
a tolerance is required for detecting points from the bottom of the vessel. Default: 1 m (3.28 ft.)

Restrain Coefficient [%]: Sets the level of preference of echoes from shorter distances over echoes from 
farther distances. 100% = no preference of closer echoes. 0% = total preference of the first echo. Default: 
10%. 

User False Echoes: Enable/Disable, Sets the algorithm to consider the false echo mapping created 
manually by the user (enabled by default). Setting this parameter to Disable causes the device to ignore 
the manual false echoes.

Auto False Echoes: Enable/Disable, Sets the algorithm to automatically calculate false echo levels 
(enabled by default). Setting this parameter to Disable stops the device from continuously calculating 
the false echo levels and keeps the last image of false echoes. If the false echoes are manually reset, the 
level is set to 0.
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Figure 7-59. Side and Bottom Margins

r = Bottom Margins

Beams Activation tab
The Beams Activation tab allows choosing manual or automatic (by the algorithm) beams selection. By 
default, the beams are selected automatically. Part of the beams will be removed depending on silo 
dimensions.

 High (7KHz), Med (4.5KHz) and Low (2.3KHz) Frequency beams represent three separate 
transmissions which emit signals from all three antennas simultaneously.

 30, 90, 150, 210, 270 and 330 degrees directions represent six separate directional transmissions 
which improve the algorithm's analysis of the returned echoes. All six transmissions are transmitted in 
the same frequency as the Med frequency.

 Beams can be enabled or disabled by removing the check box from the Auto Beam Selection box. A 
selection of less than three directional beams is not allowed. Only a selection of at least three 
consecutive beams is possible, for example: Direction 30, Direction 330 and Direction 270.

 Automatic Beams Range: Enabled by default. The beams range is limited according to the range at 
which the beam hit the vessel wall. Low frequency beam has wider angle and thus is more limited. High 
frequency beam is very narrow and has no limitations. At every possible beam selection the algorithm 
makes sure that at least one beam has enough range to 'see' the bottom of the vessel. This limitation is 
visualized in the Echo Curve analysis window as the orange vertical line.

r r

r

r r
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Figure 7-60. Advanced Parameters - Beams Activation

7.5.3 Device current simulation settings
The output current can be simulated by setting Volume (%), or Current (mA). This feature is useful for 
synchronizing with the PLC and verifying of identical read values for both the Rosemount 5708 and the 
PLC. 

1. On the Device menu, select Device Current Simulation Settings or press F6.

2. Select Volume or Current Simulation from the drop down list and fill the value field, volume can be 
between 0 to 100%. Current simulation settings can be between 4 to 20mA.

3. Select Apply to set the changes in the device, to stop current simulation select ‘Simulation Off’ and 
select Apply.

The Current simulation status of the device may be terminated by either restart or power reset.

Figure 7-61. Current Simulation Settings

Note
Turn off current simulation by selecting Simulation Off and select Apply.
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7.5.4 Device output current
These settings allowing the user to control the various options of the 4-20mA connection. Setting the 
output to represent volume of level, setting fault current and conditions and changing the HART 
command #3 to different values.

Current Output Types
Standard 4-20mA (Volume) - the current will represent the volume of the material in the vessel based 
on vessel configuration and settings.

Standard 4-20mA (Level) - the current will follow the level of material inside the vessel and be calculated 
based on the full and empty calibration levels. It is also possible to select whether the current will be the 
average level, minimal level or maximal level. Min and Max levels are available only if the model is 
Rosemount 5708V or 5708S.

Inverted 20-4mA (Distance) - the current will follow the distance of material inside the vessel and be 
calculated between the full and empty calibration level. It is also possible to select whether the current 
will be the average distance, minimal distance or maximal distance. Min and Max distances are available 
only if the model is Rosemount 5708V or 5708S.

From the Device menu, select Device Output Current or select the F8 key on your keyboard.

Note
Distance in multi-scanner system is calculated from the top of the silo.

Fault Current settings - selecting an output signal and the condition to activate it. The fault current can 
be 3.6mA or 22mA, by default there is no fault current. Fault indication trigger can be by temperature or 
volume measurement.

HART Command #3 - changing the 4 default variables to any combination of the available measurement 
variables.
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7.5.5 Device output settings
The Device Output Settings defines the displayed calculation and how the 4-20mA output behaves. The 
output type of Volume (default), Mass, Level or Distance can be selected.

Material name and color can be selected from the list of materials and edited. For additional details, see 
“Material configuration” on page 127.

Rosemount 5708 measurement units can be modified. The measurement units are the same as defined 
in the Configuration Wizard.

On the Device menu, select Device Output Settings or press F7.

Output type: volume
Calculation Using Silo Structure – Calculates the volume based on the silo structure defined using the 
configuration wizard. The displayed units can be selected to be available to the user.

Figure 7-62. Output Type Volume by Silo Structure
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Calculation Using Level-Volume Table – Allows setting a linearization table based on level to volume 
conversion.

Figure 7-63. Output Type Volume by Level-Volume Table

Select Edit Table... to edit the Level-Volume Linearization table.

If the Level to Volume option is selected, the 2 editable columns are Level [m] and 
Volume [m^3], as shown in Figure 7-64.

Figure 7-64. Level-Volume Linearization Table
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Calculation Using Distance-Volume Table – Allows setting a linearization table based on distance to 
volume conversion (to be done the same as above). In this case, the two editable columns are Distance 
[m] and Volume [m^3], as shown in Figure 7-65.

Figure 7-65. Distance-Volume Linearization Table

Calculation Using Level-Mass Table – Conversion of the calculated average level directly into mass.

Figure 7-66. Output Type Mass by Level-Mass Table

Select Edit Table... to edit the Level-Mass Linearization table.

If the Level to Mass option is selected, the 2 editable columns are Level [m] and Mass [ton], as shown in 
Figure 7-67.
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Figure 7-67. Level-Mass Linearization Table

Calculation Using Distance-Mass Table – Conversion of the calculated average distance directly into 
mass (to be done same as above).

Figure 7-68. Distance-Mass Linearization Table

Calculation Using Level-Variable Bulk Density Table – Conversion of the calculated average level into 
volume, based on silo structure and multiplying by the bulk density value at that level to convert into 
mass.
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Figure 7-69. Output Type Mass Using Variable Bulk Density

Select Open Table... to open the Level-Bulk Density Linearization table.

If the Level to Variable Bulk Density option is selected, the 2 editable columns are Level [m] and Dens. 
[ton/m^3], as shown in Figure 7-70.

Figure 7-70. Level-Bulk Density Linearization Table

Calculation Using Distance-Variable Bulk Density Table – Conversion of the calculated average 
distance into volume, based on silo structure and multiplying by the bulk density value at that distance 
to convert into mass (same as above).
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Rosemount 5708 output settings button functions
Output Settings windows buttons functionality:

 Edit Table – when available, the table can be edited according to the requirements

 OK – keeps settings and advise upload the changes to the device

 Close – discards all changes and close the window

Table buttons and functionality:

 Export/Import: Exports or imports .xml file.

 Reset Levels – Set the level/distance values 

 Apply – upload all updated settings to the device

 OK – saves the configuration. Uploading from the output settings window will be required

 Close – discards all changes and closes the table window

Table editing options by right-clicking a row or column editing option available: 

 Add/Clear/Delete selected row

 Duplicate row set value as min/max capacity clearing table or column.
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7.5.6 Echo Curve Analysis

Performing Echo Curve Analysis
The Echo Curve Analysis tool collects information from the Rosemount 5708 and presents it in a chart 
-type report for each scan.

To perform an Echo Curve Analysis:

1. On the Device menu, select Echo Curve Analysis… or press Ctrl+Z.

2. Select the device(s) from the tree view pane. The devices are organized in a Site-Vessel-device view.

3. Optional: Select All Echoes Info to perform an analysis on the Rosemount 5708 to verify behavior in 
the vessel.

4. Select Start to initiate a single time Echo Curve analysis.

5. Open Viewer to open the Echo curve viewer.

If a single analysis scan is performed, then the Echo Curve Viewer will automatically pop up. To view 
the echo curve, see next chapter.

Figure 7-71. Activate Echo Curve Analysis

To perform continuous echo curve analysis, set the Every (mins) and the Duration (hours) and select 
Start.

 Every (mins): Sets the pause time between analysis scans, the pause time is measured in minutes and 
by default set to five minutes. The pause time can be set between 3 to 1000 minutes.

 Duration (hours): Set the period of time in hours to perform continuous analysis. Minimal value is 0.1 
hour (six minutes) and maximal value is 999 hours (over 41 days).
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Viewing Echo Curve Analysis
Selecting this option allows viewing of previous Echo Curve Analysis scans done. Expand the tree view 
and select one of the devices, the software will retrieve the information from the device and display all 
Echo Curve files on the right hand side of the viewer.

To view the Echo Curve Analysis: 

On the Device menu, select Echo Curve Analysis Viewer… or press Ctrl+V.

Figure 7-72. Echo Curve Analysis Viewer

A. Echo curve charts by beam
B. Chart legend
C. Selecting the device to view
D. List of echo curve files and time and date stamp

A B

DC
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The horizontal axis refers to the distance (m or feet) of the echo from the device and the vertical axis 
refers to the energy of the echo (there are no units for the energy).

Echo Curve viewer window options:

Show Fuzzy: Checking this option will show the Fuzzy Grade of the selected echoes on the chart. For 
more information about Fuzzy and what it is, contact your local Emerson technical support.

Reset the chart to the original view

m / ft: Show the distance axis in meters or feet.

Map out False Echoes: checking the map out checkbox allows the user to select a section in the echo 
curve in any of the frequency tabs and to open the false echo mapping dialog box directly with the 
selected frequency and conditions to easily map out selected false echo. See “False Echo Mapping” on 
page 112 for additional info.

High/Medium/Low… tabs: Show the echo curve result of each beam, the tab will be disabled if the 
beam was not active when the Echo Curve analysis was performed.

All Beams tab: Show just the grade of each beam in a single chart

Chart Legend (Echo, Threshold, Auto False Echo, User False Echo and Fuzzy): Show or hide each of 
the selected graphs. Fuzzy will show or hide the small square on the selected echoes in different heights 
depending on the fuzzy grade value.

Selecting the scanner to view: In this pane, a tree view of Site-Vessel-Device will appear according to 
the project, expand or collapse the tree view and select the Rosemount 5708 to view its echo’s result.

It is possible to set the page size (number of files) to view, default value is 50 files. Values can be between 
10 to 250 files.

In the Online pane it is possible to switch between pages and to download the files to the local computer.

Download Files tab: This tab holds all the echo curve files that were viewed by the user and were 
automatically downloaded to the Rosemount 3DVision Client computer.

When switching to the downloaded Files tab, it is possible to Select Local folder to save the files and to 
browse to local folder by right-clicking on one of the files.
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7.5.7 False Echo Mapping
Selecting this option allows performing False Echo Mapping on any of the beams to ignore false echoes 
inside the vessel cause by internal object or interferences.

To open the False Echo Mapping option:

On the Device menu, select Device False Echo Mapping….

Figure 7-73. False Echo Mapping

Device – select the device to perform False Echo Mapping function on.

Beams’ check-boxes – it is possible to perform any of the actions on all beams or any combination of the 
beams.

Action Type:

 Reset User and Auto False Echoes – delete all false echoes done by the Auto False Echo algorithm and 
in the False Echoes Mapping created by the user.

 Reset User False Echoes – delete all false mapping done by the user.

 Reset Auto False Echoes – delete all false echoes done by the Auto False Echo algorithm.

 Scan – automatic False Echo Mapping between the set ranges From/To distance.

 Manual Scan – set a constant level at the defined threshold between the From and To distances.

 Start Scanning (or Reset Mapping) – select to start the calculation.

Suggested steps for Echo Curve Analysis and False Echo Mapping
1. Measure the distance from the device to the material below it with a second reference, such as a tape 

measure equipped with a weight on the end, or a laser. Record the distance measurement for further 
reference.

2. Perform the Echo Curve Analysis, see “Echo curve analysis” on page 62. Once completed, the Echo 
Curve window opens (same as in “Viewing Echo Curve Analysis” on page 110).

3. Determine if the location of the echoes (vertical lines) are close to the manual measurement taken 
earlier. Note that the Rosemount 5708 is taking measurements of multiple points and may not match 
up with the manual measurement exactly.

4. Figure 7-74 is an example of the representation of false echo in the Echo Curve window. A manual 
measurement and reads 2.5 m. When comparing to the Echo Curve Analysis, echoes appear in the 
first 1m. These are clearly false echoes and will need to be mapped out.
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Figure 7-74. False Echo Example in Echo Curve Analysis Window

5. Zoom into the area of false echoes at the first 1.5 m by clicking and dragging down and to the right 
marking a square around the required area. This is done to view the exact numbers that later needed 
to be mapped out under the False Echo Mapping function.

6. Check the Map Out False Echoes check box, select the required tab or beam on which you would like to 
perform the false echo mapping, using the mouse left click mark a rectangle around the false echo 
you wish to map and release the mouse button. The Echo Mapping window will pop up populating all 
relevant fields, Click Start Scanning to initiate the operation.

7. False Echo Mapping can be also found under the Device menu. Manually scan from 0 to beyond the 
distance of the false echoes. In this case, the echo will be 1.6 m. Select Manual Scan, set the range of 
scan and the level of the threshold, in this case it can be 10000. 

8. Select the Start Scanning button.

9. Once the message disappears, the False Echo Mapping process is completed. Wait a couple of 
minutes and perform Echo Curve Analysis again to verify the position of the User False Echo line (pink) 
in each of the beams the operation was done. Wait at least one damping time before the algorithm 
takes effect of the changes and completely ignores the false echoes.

Note
This is a brief run through of the False Echo Mapping process. There are many other situations that may 
call for different techniques. An improper mapping of a vessel can lead to a poor performance.
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7.5.8 Device activations
This option can be reached from the menu Device > Device Activations….

The options under this window are:

 Devices Reset

 Update Firmware

 Com. Quality

Device reset options
Reset (Restart) Device – Sends a restart command to the device. The internal DSP boots and starts 
building the auto false echoes and damping values. The initialization process takes about 30 seconds. 
The device will perform a new search for the correct measurement.

Reset to Factory Defaults – Resets most of the system parameters to their factory default settings. All 
parameters must be re-defined following this operation. The following parameters remain unchanged: 
'Output Damping Time' and 'Steepest Material Slope'.

Reset Advanced Parameters and False Echoes – Resets all advanced parameters. This function will not 
reset the 'Output Damping Time', 'Steepest Material Slope', ‘Max. Capacity’, ‘Max. Emptying Rate’ and 
‘Max. Filling Rate’. Device configurations set in the Configuration Wizard will not restore to factory 
defaults.

Select the device(s) from the tree view on the left side and check the required option, select Reset to 
commence the operation.

Figure 7-75. Device Activation - Reset Options

Firmware update
This tool allows updating the FW to one or more devices selected in the site tree view.

1. Select the device(s) you want to perform the Firmware update using the check-boxes on the left side.

2. Select the … button to select the firmware file, it should be a file with extension .ldr.

3. Select the Start Update button to initiate the operation.

The firmware update will be performed on one device at a time. 

Once all devices have been updated, a pop-up window with hardware inventory will pop up and show the 
current FW version of all the devices. Wait until all fields are filled to verify operation.
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Figure 7-76. Firmware Update

Communication quality test
The communication quality test tool tests the connection quality between the computer and the 
selected device(s). If packets not answered, or received with errors, there is an indication in the results 
log.

In cases where the quality is not 100 percent, it is recommended that the RS-485 cable is to be checked 
for existence of proper resistors on both sides and verified to be of shielded and twisted-pair type and 
that the cable is designed for RS-485 communication protocol.

An example for a good test result: an average delay of 97msec (very low), no lost packets and no errors 
received. 

1. Set the number of cycles between 20 to 1000.

2. Select Start Test to begin the testing. The test will cycle through until terminated.

3. Select Stop Test to terminate the operation.

4. Select Show Log to open the results in a Notepad text file.

It is important to test the quality of the communication between the computer running the Rosemount 
3DVision Server and the devices after initial setup and first connection.
115Operation



Reference Manual
00809-0100-4570, Rev DA

Operation
November 2017
Figure 7-77. Communication Quality Test

7.5.9 Model upgrade
Upgrading a model is available for Rosemount 5708L and 5708V to Rosemount 5708V or Rosemount 
5708S

7.5.10 Reports Wizard

Report Wizard
On the Tools menu, select Reports Definition Wizard to access the report options or click F9 to open 
the Reports Wizard.

 Two report types available:

– Inventory report

– On Line report

 Define contacts, setting Email and SMS parameters available on report configuration window (Bottom 
left button).

 On contacts tab user can edit contacts details.

 Mail setup parameters must be entered in order to receive email notification.

 SMS setup parameters.

Inventory report
1. Step 1 - Report Type

 On first activation, user should select the <Template_Report> and continue to next steps definitions. 
On last step, user required to save the settings to new name (for ex. "Automation default report").

 Running immediate report is available by selecting report and press the Run button.

 Rename and delete reports is possible to non-template report only. 
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Figure 7-78. Report Type

2. Step 2 - Information

 User able to define if current report will be active or not, by Active check box.

 Title and Description fields are just informative fields for step 2 and doesn't go out to report 
information.

 Excel report file name define on File Name field.

 Output Header fields are informative fields, which display on report file.

Figure 7-79. Information

3. Step 3 - Population

 Choose which vessels will be included on report.

 Selection may be made by material type (select material and press Apply).
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Figure 7-80. Population

4. Step 4 - Data Collection

Select which measurements will be included on report.

Figure 7-81. Template_Report

5. Step 5 - Data Output Type

Five data output types are available:

1.1 Periodic Site Vessel
 a. Create separate report file for each site, according to population selection (step 3). 
b. Single report contains all schedule measurements according to schedule settings - step 6.
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Figure 7-82. Periodic Site Vessel 

2.1 Periodic Vessel
a. Create a separate report file for each Vessel, according to population selection (step 3). 
b. Single report contains all schedule measurements according to schedule settings - step 6.

Figure 7-83. Periodic Vessel

3.1 Sum Total Material Project
a. Sum selected measurements for each material - for whole project according to population 

selection (step 3).
b. Each scheduled report created on separated file.
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Figure 7-84. Sum Total Material Project

4.1 Sum Total Material Site
a. Sum selected measurements for each material on each site.
b. Each scheduled report created on separated file.

Figure 7-85. Sum Total Material Site 

5.1 Sum Total Material Site Vessel
a. Summarize all selected vessels measurements.
b. Each scheduled report created on separated file.

Figure 7-86. Sum Total Material Site Vessel

6. Step 6 - Schedule

Schedule interval options: Daily, Weekly, Monthly, One-time event.
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Figure 7-87. Schedule

Note 
Interval option just declare the directory order, where report files will save.

For example: On daily report, it will create directory every day and put all day reports into it.

Interval OptionFolder ex.

Daily 

Weekly 

Monthly
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7. Step 7 - Status

 User can select who will get SMS and Email every time report creates.

 Define contacts information available on “Reports Wizard” on page 116.

Figure 7-88. Output

Note
User must fill in Mail setup and SMS setup information, on report configuration window, in order to use 
those services.

Note
SMS message includes only notification of report creation without measurements values. For Ex.: 
“Report Generation Wednesday, February 22, 2017 12:00:00”

Online report
Online report allows users to save measurements into file which update every interval time.

1. Step 1 - Report Type

User should select the “Online Report” and continue to next steps definitions.

Figure 7-89. Report Type
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2. Step 2 - Information

 User able to define if current report will be active or not, by Active check box.

 Output file will create on the selected report folder. Measurements will update according to “Write 
interval” time.

Figure 7-90. Information

3. Step 3 - Population

 Choose which vessels will be included on report.

 Selection may be made by material type (select material and press Apply)

Figure 7-91. Population
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4. Step 4 - Data Collection

Select which measurements will be included on report.

Figure 7-92. Data Collection

7.5.11 Event log

Figure 7-93. Event Log View
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Hardware inventory table
The hardware inventory table lists the following:

 All sites included in the project with their names, descriptions, and server names.

 For each site, the included vessels are listed with their names.

 For each vessel, the devices related to that vessel are listed below it.

The table contains the following properties per the included items: Vessel, Serial Number, Hardware and 
Firmware versions of the devices, Polling Address, model, and Connection type, Communication Port, 
Chain ID and SCADA ID.

Note
SCADA ID - Each vessel gets its own SCADA ID, and each scanner has a separate SCADA ID. This allows 
separating measurements of scanners from the vessel in multi-scanner system.

Chain ID is used in cases where the Rosemount 3DMultiVision is connected to multiple devices over 
multiple chains and the user wants to connect to a specific device from the Rosemount 3DVision.

SCADA ID is assigned per vessel and used when connecting a SCADA system to retrieve the registers of 
the vessel. 

To create a hardware inventory table:

 Select Tools > Reports > Hardware Inventory Table. The table opens in a separate window (Figure 
7-94).

The data displayed is updated when the Refresh button is selected.

Figure 7-94. Hardware Inventory Table

Measurement summary table
The measurement summary table lists the Volume (absolute), Volume %, Mass, and Alerts for all vessels 
on all sites, grouped by site.

The table lists the measurement units reported by the devices.

To activate the measurement summary table: 

 Select Tools > Reports > Measurement Summary Table. The table opens in a separate window 
(Figure 7-95).

 Select the Refresh to update the displayed data.
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Figure 7-95. Measurement Summary Table

Demo mode
The Demo mode is useful for demonstration and marketing purposes, and for understanding system 
operation.

The Demo mode loads a demo project with pre-defined sites, vessels, and devices and their 
configuration, and activates a simulation of filling/emptying operations over time. Most software 
features are available in demo mode, allowing the user to view reports, 3D visualizations, logs, and 
time-based charts and their behavior over time.

To initiate the Demo mode:

1. On the Tools menu, select Demo > Start Demo Running. The Projects window appears with a list of 
various demo projects, such as Aggregates, Chemicals, Food, and more.

2. Select a demo project and click Select. The demo project loads with all its sites, vessels, and devices, 
and simulation begins.

The following options are available in the Tools > Demo drop-down menu:

 Stop Demo Running: Exits the demo mode and opens a project selection box.

 Restart Demo Running: Brings the demo values to their initial levels and continues the simulation 
while keeping demo history.

 Fast Run/Normal Run/Slow Run: Runs the demo mode simulation at various speeds. By default, the 
Normal Run option is selected.

 Reset Demo Date (Server): Restarts the demo mode.

Note
The demo mode must be stopped before the system can return to normal operation. Exiting and 
restarting the application will not stop the demo mode.

7.5.12 User management
The Rosemount 3DVision/3DMultiVision software enables several user levels. Each level has different 
authorizations for accessing system features. Multiple users can be added to the system and their 
authorization levels set.

The available user level options are:

 Administrator – Has all privileges except for changing device configuration, communication and 
polling address. Default user name: admin, default password: admin

 Senior Technician – Has privileges to configure all of the devices parameters including configuration 
wizard, advanced parameters and more. Default user name: stech, default password: techS

 Viewer – Only has viewing capabilities.
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To access Users Management: 

Select Tools > Users Management. The Users window opens allowing the user to add and delete users 
and set a user name, password, and authorization level. Only Administrator can add or remove users with 
different privileges.

The Users Authorization is Enabled check-box, when unchecked, causes the server to ignore the 
defined user authorizations, enabling the user to enter the system without a password and log in with 
administrator privileges.

Figure 7-96. Users Management

7.5.13 Material configuration
The software includes a convenient tool for managing material types which are represented by names 
and colors. Materials can be added to the project with their names and their colors chosen. When setting 
up vessels, a stored material may be selected, with its color representing the vessel.

To open the Material Configuration tool: 

Select Tools > Material Configuration. The Material Configuration window opens (Figure 7-97) including 
the options to add, delete, or modify and store material descriptions and colors.

To add a new material:

1. In the Material Name box, type the new material name.

2. Select the […] button.

3. In the Material Color Selection list, select the desired color. The vessel image automatically changes to 
display the stored material with the selected color. 

4. Select the Close button.

5. Select Add. The new material is added to the list.

To edit a material:

1. In the Available Materials list, select the material to be modified.

2. Type a new name or select a different color and select Edit.

To delete a material:

In the Available Materials list, select the relevant material and select Delete.
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Figure 7-97. Material Configuration

7.5.14 3D visualization
A 3D visualization of the vessel includes the device(s) located on it, the material stored, and several 
control options. The level and surface of the 3D visualization is shown as measured by the device(s).

To view the 3D visualization:

 Select a vessel from the vessel selection bar. The 3D visualization is displayed in the right pane of the 
main work area.

OR

 Select a site and right-click on a vessel box in the main work area. Select Show 3D Profile. The 3D 
visualization opens in a new window.

The 3D visualization includes the following options:

 Navigation stick: Enables four-directional image tilt and rotate over the X and Y axes. A central home 
button brings the axis back to 0° position and resets the magnification.

 Magnification slider: Enables changing the image magnification in and out.

 On line check-box: (This only appears when viewing the 3D visualization in the main work area.) When 
checked, the image is displayed in accordance with the current material measurements. When 
unchecked, the view changes to an animation showing the stored material level and surface changes 
over a selectable time period (Figure 7-99).

 Play/Stop/FF/REW animation control buttons.

 Time bar with location knob.

 Interval: Sets frame rate in milliseconds.

 [] button: Changes the animation date range.

 […] button: Opens an existing animation file.
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Figure 7-98. 3D visualization

Figure 7-99. Animation Control Bar

Additional 3D visualization related functions are available by right-clicking on the image.

Figure 7-100. 3D visualization Functions

Table 7-6.  3D visualization Functions

Function Description

Show Vessel Geometry Only Removes the material representation leaving only the vessel shape.

Show Device Shows the device(s) in their configured locations on the top of the 
vessel.
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7.5.15 Multi-server connection
The Rosemount 3DMultiVision software includes an option to connect to multiple servers by entering 
their server name, address, and port number.

Show Fill Points Adds small arrow icons to represent the location of the filling points 
based on the configuration.

Material Color… Opens the Material Color Selection window to select the material color.

Show axes Shows the user the X, Y, and Z axes.

Activate Pan Mode Allows the user to move the 3D visualization (as opposed to rotating).

Save Image As... Saves the current image as a JPEG file on the computer.

Misc ► Additional functions:

Show Silo Dimension Walls Adds grid walls with dimensions.

Show Figures Show or hide text added in the Vessel graphic figures option.

Show Scanner Name Displays the device's Tag Name and polling address.

Show Scanner Position Shows the device (x, y, z) position near the device display.

Show Device Offset Holder Shows the device neck extension/extension pipe according to the 
offset configured in the Configuration Wizard (step 2).

Show Full and Empty 
Calibration

Adds circles at the level of the full and empty calibration levels.

Draw Silo Grid (Wireframe) Adds grid to the material surface.

Show Solid Material Color Switches the gradient material color to a single color.

Fill Bounds With Material Fills the bounds of material and silo with the same color as the material.

Hide Top Shape Hides the top part of the silo in case it is a cone, dome, or pyramid

3D Algorithm Accuracy This feature enables to have higher image resolution, but slows the 
process and takes time between each option.

Device Components Size Displays the Rosemount 5708 in its actual positioning. There are four 
options available: Real, Relative Large, Relative Normal, and Relative 
Small.

View ► Viewing the 3D visualization from different angles:
 Original

 View from Front

 View from Top

 View from Left

 View from Right

 View from Behind

 View 3D

Function Description
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To receive data from a server:

1. On the Tools menu, select Tools > Client Options.... 

2. Select Server Connection Mode. 

3. Select the Multiple button. A confirmation dialog box appears to confirm the action.

4. Select Yes. The client application closes and reopens with the Servers Connection window open.

5. In the top left corner of the Servers Connection window, select the Advanced check box. Additional 
options appear in the window (Figure 7-101).

6. Select the name and select Add Server to define the new server. The Server Connection window 
opens. 

7. Enter the Server Name, Server Address, and Server Port. Click Select. 

8. Select the server from the list. Select Connect to connect to the selected server, or Connect All to 
connect to all servers listed.

9. Select Login Server to login to the selected server, or Login All to login to all servers listed. The Login 
window opens requesting a user name and password. 

10.Enter the relevant user name and password and select Sign In.

11.In the Servers Connection window, select OK. The Rosemount 3DVision Client application loads the 
data of the relevant server.

Figure 7-101. Servers Connection Window

The Servers Connection window includes the following additional options:

 Move Up/Move Down: Allows the user to toggle between servers in the list.

 Edit Server: Opens a dialog box with details of the selected server.

 Edit Server/Delete Server: Adds, deletes, or renames an existing server from the Phone Book name 
List pane.

 Export/Import: Exports or imports .xml file.

 Close: Closes the client application.
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7.5.16 Upgrading to Rosemount 3DMultiVision
When upgrading from Rosemount 3DVision to Rosemount 3DMultiVision version, a license key is 
required. The change takes effect immediately and does not require a restart of the client PC. 

1. On the Tools menu, select Server Option.

2. Select License Key.

3. Enter the license key and select Apply.

Figure 7-102. Server Configuration

The Rosemount 3DMultiVision software may be installed and activated for up to 30 days without a 
license key. After 30 days, the software requires a valid license key. During the 30-day period, the 
software generates licensing reminder messages from time to time. Check the Don't Remind check-box 
to disable these reminders.

Note
One license code is required per application.

Advanced tools:

1. Output measurements per Section.

2. Center of Gravity Alert

Server configuration window was updated with new licenses, “Edit” checkbox appears when license 
already inserted.
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Figure 7-103. License Key

7.5.17 Center of Gravity 
Center of Gravity (CoG) is a licensed option. Enter the activation code in Tools > Server Options > License 
Key. Click to Apply button to accept the code and close the window. See Figure 43.

Center of gravity is calculated based on the 3D image of the scanner and displayed in the 3D image. It 
also shows that allowed area for the CoG.

To set center of gravity, right-click the vessel when in site view mode, select Properties… and switch to 
the Alerts tab. See image below.

 Set the center point of the box that defines the CoG and set the box dimensions. Click OK.

 On the 3D image, right click and select Show Vessel Geometry Only. This option will remove the 
image of the material.

 Right click the 3D image, select Misc and select Show Center Gravity. This will show the defined box 
and the center of gravity point (represented with a small inverted cone) with the calculated 
coordinates, see Figure 109.

 In the Vessel overview, on the bottom of the measurements, the COG coordinates is added as a 
reference.

 When the center of gravity is outside the box, an alert will appear, see Figure 110.

 Calculated Center of Gravity coordinates can also be read via SCADA connection on Modbus registers. 
The holding registers are: X – 49983-4, Y – 49985-6 and Z – 49987-8. All are floating points numbers.

 To cancel the Center of Gravity, set all fields in Figure 7-104 on page 134 to zero.
133Operation



Reference Manual
00809-0100-4570, Rev DA

Operation
November 2017
Figure 7-104. Center of Gravity Settings

7.5.18 Level by Section Output
The option to output the level per section is licensed. Enter the activation code in Tools > Server Options 
> License Key. Click to Apply button to accept the code and close the window.

By activating this feature the 3DVision can output the minimal, maximal, and average level in each 
section. The level in each section is calculated from the 3D image of the material in the vessel and 
displayed in the 3D image.

To set the Sections, right-click the vessel when in site view mode, select Properties… and switch to the 
General tab, see Figure 7-105 on page 135.

1. Set the number of sections on X axis and the number of sections on Y axis; the total number of 
sections is equal to X * Y and limited to 99 sections. Set the number of sections to 1 in order to 
deactivate this feature.

2. Minimal size of a section cannot be smaller than 5ft. � 5ft. (1.5m � 1.5m).

3. Right -click the 3D image, select Misc and select Show Sections. This will show the grid of sections on 
top of the 3D image. See Figure 109 for an example of six sections.

4. Calculated section levels can also be read via SCADA connection on Modbus registers. The holding 
registers are:

 41001 – Sec 1 Avg. Level

 41003 – Sec 1 Min Level

 41005 – Sec 1 Max Level

 41021 – Sec 2 Avg. Level

 41023 – Sec 2 Min Level

 41025 – Sec 2 Max Level

 41041 – Sec 3 Avg. Level

 41043 – Sec 3 Min Level

 41045 – Sec 3 Max Level
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5. All are floating points numbers.
6. An additional integration option can be done by creating a file holding the data and updated upon 

request. To set the file’s path, see Figure 42 on page 38. The file is generated on the Server Computer. 
To update the file, invoke a Modbus read request to register 49981. See an example of output file in 
Figure 7-107 on page 136.

Figure 7-105. Section Settings

Figure 7-106. Virtual Sections
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Figure 7-107. Example of Sections Output to a File

Note
One license code is required per 3DVision Server installation.
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Section 8 Configuration - 
Rosemount 5708 in a System

System overview and components . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .page 137
Rosemount System Controller advantages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .page 139

System requirements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .page 140
Mounting the Rosemount System Controller  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .page 141
Advanced commissioning steps  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .page 142

8.1 System overview and components
The system of multiple Rosemount™ 5708 has been specially designed for wide silos, open bins, and 
warehouses where the diameters or areas to cover are exceptionally large.

The system consists of multiple Rosemount 5708S units mounted in a manner allowing the devices to 
cover the whole area with high accuracy.

The system is comprised of Rosemount 5708 and an industrial computer-based Rosemount System 
Controller, enclosed in a metal cabinet with direct RS-485 connection to the devices.

The Rosemount System Controller is comprised of a lockable metal cabinet which contains:

 Industrial computer unit

 Four-port terminal block for wiring

 Two M25 cable glands for cables insertion 

 Grounding screw
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Figure 8-1. Components of a Rosemount System Controller

A. Rosemount System Controller computer
B. Power supply terminals, one for +24 Vdc, two for -24 Vdc (or GND)
C. USB to RS-485 converter
D. RS-485 terminals, three for D+, four for D-
E. Spare DIN rail for other components as 24 V power supply, barriers, etc.
F. Two M25 cable glands

A

B

C

D

E

F
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Figure 8-2. Rosemount System Controller - Computer Front View

A. Speaker out
B. Two USB ports
C. Ethernet #2 port - set to fixed IP Address: 192.168.99.99
D. Ethernet #1 port - set to dynamic IP Address
E. VGA port for external display

8.2 Rosemount System Controller advantages
The Rosemount System Controller features several major functions which bring a synergetic quality to 
the multiple devices positioned in the same bin:

 Synchronizes device transmissions while preventing mutual device interference

 Keeps signal-to-noise ratio performance uncompromised

 Takes into account returned echoes from all devices in the system

 Generates a complete, merged 3D visualization of the entire bin

 Updates and synchronizes 4-20mA outputs of all devices to the overall content percentage, requiring 
only one Rosemount 5708 to be connected to the control room.

 The accurate, timed inventory monitoring enables material ordering to meet production needs, 
avoiding costly emergency fills.

A C B

E
D
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8.3 System requirements

Figure 8-3. Multiple Rosemount 5708 Connection

All devices must be daisy-chained with a power supply and RS-485 links to the Rosemount System 
Controller. A single 4-20mA pair must be wired from only one of the chained devices to the 
PLC/DCS/SCADA/Etc. The 4-20mA may be connected to any of the devices.

The Rosemount System Controller cabinet must be installed indoors, mounted on a wall, and wired to 
the devices and a power supply for the computer operation. A single 24 Vdc power supply is 
recommended for powering the computer and the devices. Consider power consumption as well. The 
computer is rated 40 W with 24 Vdc power supply, and each device is rated 1.5 W with the same power 
supply.

A. RS-485 converter
B. RS-485 (+)
C. RS-485 (-)
D. Device 1

E. Device 2
F. Device 3
G. Device n
H. 120 Ohm

A
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8.4 Mounting the Rosemount System Controller
The Rosemount System Controller metal cabinet is designed for wall mounting using four screws. The 
mounting location should be selected with considerations of the cabinet size and providing enough 
space allowing the door to open to the right.

Figure 8-4. Metal Cabinet - Mounting Holes for Wall Mounting

Dimensions are in inches (millimeters). 

Note
A readily accessible disconnect device (such as two-pole) switch or circuit breaker rated minimum
60 Vdc/5A, marked with ON and OFF position and compliant with IEC 60947-1, IEC 60947-3, should be 
added externally to the Rosemount System Controller cabinet to disconnect “+” and “-” of the supply 
circuit.

Note
When installing the supply and data wiring, the wiring must be properly fixed in place (e.g. by tie wraps 
and additionally by the cable glands) to be sufficiently resistant to undesired pull.

Protection provided by the equipment can be impaired if used in a manner not specified by the 
manufacturer.

Risk of explosion if battery in PC is replaced by an incorrect type. Replace only with the same type or 
manufacturer.

19.7 (500)

Ø 0.3 (8)

0.9 (23)

0.82 (21)

11.8 (300)
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8.5 Advanced commissioning steps
When the system is operating and providing measurements, the Rosemount System Controller is used 
for running the Rosemount 3DVision Server application that synchronizes and merges the devices and 
delivers data to the Rosemount 3DVision Clients. It is also recommended to use the Rosemount System 
Controller computer for configuration and adjustments, and for executing the Rosemount 3DVision 
installed in it.

The recommended method of operation and steps to be taken during the installation of multiple 
Rosemount 5708 in a system are detailed below in chronological order:

Step 1. Rosemount 5708 installation

Make sure all required documentation is available: Application Evaluation Form (AEF) and Vessel 
Drawings.

Compare Locator suggestion or mounting location as suggested by Emerson™ with the actual 
Rosemount 5708 mounting positions.

Perform manual measurements of the vessel dimensions, and compare results with the 
drawings.

Check 24 Vdc input to all devices.

Check RS-485 link between devices and the Rosemount System Controller. Make sure the 
resistance between D+ and D- is 60 ±5% Ohm.

Check 4-20 mA connection to the local PLC. Perform current simulation from the device 
connected to the PLC.

Power up all devices and check polling addresses.

Set polling addresses, make sure each device has a different polling address and one of the 
devices is set with polling address of 00. See Section 6: Configuration - Rosemount 5708V and 
5708S for more information.

Write down the polling addresses on the vessel drawings for all devices.

Verify all devices for proper functioning after power up. This can be verified by connecting each 
Rosemount 5708 directly to a computer.

Verify sound signal transmission from all devices.

Get material status (level/distance/volume) according to the process manager .

Complete all required information from the process manager in order to complete the 
Rosemount 5708 configuration.
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Step 2. The Rosemount System Controller

Step 3. Rosemount 3DVision and Rosemount 5708 configuration

Mount the Rosemount System Controller cabinet indoors. Ensure it is accessible for power 
supply, Internet connections and for maintenance.

Verify proper connection of the Rosemount System Controller to a proper power supply.

Connect the provided crossover Ethernet cable (Ethernet port #2) from the Rosemount System 
Controller to a local laptop or other computer.

Set the IP Address on the laptop to static IP: 192.168.99.xx (where xx can be any number 
between 001 to 255 except 099) and subnet mask 255.255.255.0. Do not forget to restore to 
previous state once installation is complete.

Install UltraVNC version 1.0.8.2 on the laptop.

Using the UltraVNC Viewer, take control over the Rosemount System Controller using IP address 
192.168.99.99 and password 'admin'. It is recommended to use UltraVNC version 1.0.8.2.

Make sure the Rosemount System Controller is installed with the latest SW version of 
Rosemount 3DVision. If it is not, download the required latest versions from the website or 
contact the local Emerson representative for further assistance.

Execute Rosemount 3DVision and connect to all devices using RS-485 (or TCP/IP, according to 
the actual connection) in multiple mode.

If the converter’s serial COM port used for the USB-to-RS-485 converter connection is not found 
automatically, locate it manually using the computer Device Manager.

Verify latest firmware version and proper connection for all devices.

Configure the first device and save the configuration file.

Proceed with the configuration for the rest of the devices (or by uploading the first device 
configuration and changing the name tag, device location, device horizontal angle, and setting 
the full and empty calibration levels accordingly).

Specifically check the full and empty calibration levels.

Perform echo curve analysis for all devices and verify correct readings. Map false echoes, fine 
tune and adjust as needed.
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Step 4. Rosemount 3DVision Clients

Connect the Rosemount System Controller to the local area network using Ethernet port #1

Request local IT to ensure the following TCP Ports are open and will not be blocked by any 
firewall or antivirus in the local network: 22220, 22221, 22222, and 22223.

Configure the network card to a static IP address provided by the local IT. Take note of the 
Rosemount System Controller IP address - it will be required for all additional Rosemount 
3DVision Clients.

Install Rosemount 3DVision Client on all required computers on the same local area network 
(LAN) or consult with the local IT regarding the method of connection.

Establish a connection to the Rosemount 3DVision Server from the Rosemount 3DVision Client 
running on the local PC using the Server IP address of the Rosemount System Controller IP 
written beforehand.

Ensure the system and the vessel are connected.
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Section 9 Service and Troubleshooting
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9.1 Maintenance

9.1.1 Preventive maintenance procedure
The following periodic maintenance procedure is recommended for keeping the Rosemount™ 5708 in 
proper operating conditions and preventing unnecessary malfunctioning which may be caused by 
environmental factors during time:

 Clean the interior part of the antennas (see details below).

 Visually check and ensure the communication and power cables are in good condition and are not 
damaged.

 Check and ensure proper sealing of cable entry openings.

 Open the rear side of the Rosemount 5708 head and ensure absence of wetness.

Antenna cleaning guidelines:

 Disconnect power to the Rosemount 5708.

 Disassemble the mounting plate and carefully pull out the entire Rosemount 5708.

 Use a brush or wet cloth for the purpose of cleaning.

 As necessary, water can be used for cleaning.

 Avoid usage of sharp tools such as screwdrivers for cleaning. Such tools may damage the membranes.

 Avoid strong air purge or direct water current on the membranes.

9.1.2 Preventive maintenance frequency
The frequency of the maintenance procedure is subject to the conditions and the type of material stored 
in the vessel. In the case of materials such as salt, sugar, calcium carbonate, etc., treatments should be 
more frequent.
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9.2 Log views
When a site or a vessel is selected and its properties are shown in the main work area, select the Logs tab 
to view its logs. The main work area displays logged data in historical chart representation for both site 
and vessel (see Figure 9-1 and Figure 9-2).

Figure 9-1. Site Logs (Demo Run Example)

Figure 9-2. Vessel Logs (Demo Run Example)

Collected data is displayed on one, two, three, or four charts in online mode and continuously updating 
the charts or over a selected time period. Available options are Level, Volume, Volume %, Mass, SNR and 
Temperature of the selected vessel or site. SNR and Temperature cannot be viewed in Vessel mode.

To select the charts for display, click the sprocket icon. The Charts Layout Setup window opens. In each 
field select the desired chart to display and select OK.
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To magnify a selected area in the chart, click and drag over the chart creating a rectangular area. Release 
the mouse button to magnify the chart in accordance with the selected area.

To pan a specific location in the chart, right-click inside the chart and drag. The chart area pans in 
accordance with the dragging location.

To cancel all zoom and pan activations applied on all graphs and return the display to the original view, 

select .

9.3 Vessel Data Collection (VDC)
In order to simplify the data collections on a selected vessel for troubleshooting the Rosemount 5708, a 
simple data collector process was developed by clicking a single button.

1. Select the VDC button. A dialog box will pop up asking to fill required details. All fields are mandatory 
and recommended to be filled in order to provide better service.
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2. Check Send file automatically to tech. support data storage if the computer is connected to the 
Internet. If you choose not to send the file automatically, only the VDC zip file will be created on server 
local drive.

3. After data collection is completed, a link to the local folder where the zipped file located in will appear 
and the file can be sent in a different method. 

4. Select Yes to continue.

5. Initiating the data collection will change the window to image below. 
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6. When the data collection process is completed, a run summary will appear at the bottom of 
the dialog box indicating Start, End time and Status.

7. On the bottom part of the dialog box the path in which the zip file is saved will appear, 
allowing right-clicking on it to perform two operations: “Explore to VDC Directory” and 
“Copy File Name”.

The data collector collects the following information: Customer Data and problem description, 
Computer data, Rosemount 3DVision data and log files from the last seven days. It will also 
perform communication quality test and perform Echo Curve analysis on the vessel 10 times. All 
files will be zipped into a single file to simplify the transfer process.

It is possible at any time to stop the process and the files will not be sent.

On a typical vessel with one Rosemount 5708, the data collection operation should take about 
15 minutes. Uploading to the storage depends on the Internet quality connection.



Reference Manual
00809-0100-4570, Rev DA

Service and Troubleshooting
November 2017
9.4 Removing the Rosemount 5708 head
1. Verify the power supply and data communication wires are disconnected.

2. Remove the rear panel. 

3. Gently remove the antenna cable connector.

4. Remove the cable clamp.

5. Loosen the front screw.

A. Open wrench (13 mm)
B. Hex key (4 mm)

4x

B

A
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6. Make sure to pull the head all the way up until it leaves the top of the neck tube.

7. Remove the head from the neck tube.

9.5 Changing the Rosemount 5708 antenna
Replace the antenna only in the case of failure. Changing the antenna requires it to be taken out of the 
silo.

1. Verify the power supply and data communication wires are disconnected.

2. Remove the Rosemount 5708 head. For detailed instructions, see “Removing the Rosemount 5708 
head” on page 150.

3. Unscrew the bolts from the mounting plate.

4. Remove the Rosemount 5708 antenna with the mounting plate from the silo.

5. Remove the nut from the neck tube.
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6. Disassemble the mounting plate from the old antenna.

7. Install the mounting plate on the new antenna. 

For reassembly procedures, refer to “Physical mounting” on page 17.

9.6 Diagnostic messages
The system does not give diagnostic messages. It gives indications, such as colored buttons. See 
Parameters and alerts  below.

9.7 Parameters and alerts
The system allows for defining and displaying alerts of various types. Alerts are shown in a circular 
indicator located on the vessel icon in the vessel selection bar, the vessel rectangular boxes displayed 
when a site is selected, and in the vessel Overview tab. In addition, the vessel box in the overview tab 
provides a description of the alert.

9.7.1 Alert types
The system uses the round condition indicator to provide alerts for configuration and different 
notifications:

 System Notifications (in red): When the Rosemount 5708 is measuring temperatures below or above 
the specified temperature limits.

 Configuration Notifications (in yellow): When the Rosemount 5708 settings are not identical to the 
corresponding vessel settings (all configuration wizard settings except device position and horizontal 
angle).

The description of this alert is displayed above the vessel image in yellow font.

Vessel volume alert: Alert the operator that the material inside the silo exceeds the maximum value or is 
below the minimal value. Such indications will turn the entire vessel box red in site view, under the 
overview tab. This alert is activated when minimum and maximum volume thresholds are set.

Alerts appear in different colors for various failure conditions as follows:

 Grey: No connection

 Orange: Wrong configuration warning

 Red: Serious equipment malfunctioning, usually devices

 Green: indicates a proper condition
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9.7.2 Selecting properties to be displayed
The alerts indicated per vessel can be selected. To select alerts for a vessel, right-click a vessel 
rectangular box (when a site is selected) and select Properties. The Parameters Definition window for 
the specific vessel opens (Figure 9-3).

In the Data Selection tab choose the parameters to appear in the vessel box under the site selection. By 
default, the following parameters are selected and shown:

 Distance/Level (the distance or level parameter is shown as configured)

 Maximum and Minimum Distance/Level

 Volume (%)

Figure 9-3. Parameter Definition - Data Selection

Parameters can be removed and added, and the order they appear inside the vessel box can be changed.

 To remove a selected parameter, select the parameter for removal and select .

 To remove all selected parameters, select .

 To add a parameter, select the parameter from the Available pane and select .

 To add all available parameters, select .

 To move a selected parameter up, select the parameter from the Selected pane and select .

 To move a selected parameter down, select the parameter from the Selected pane and select .

9.7.3 Setting alert threshold
The alert threshold is specified in the Alerts tab of the Parameters Definition window (Figure 9-4). This 
triggers an alert when the material volume is above or below these values.
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Figure 9-4. Alert Threshold

To define the alert thresholds:

1. Check the relevant option (or both). An unchecked option does not generate an alert for this vessel.

2. Set the value in volume percent where an alert should be generated above this value (maximum) or 
below this value (minimum).

3. Once set, an alert is generated when the material volume exceeds the maximum value set or drops 
below the minimum value set.

9.7.4 General tab
Set the number of sections on X axis and the number of sections on Y axis. The total number of sections 
is equal to X * Y and limited to 99 sections. Set the number of sections to 1 in order to deactivate this 
feature.

Figure 9-5. Section settings
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9.8 Service support
To expedite the return process outside of the United States, contact the nearest Emerson™ representa-
tive.

Within the United States, call the Emerson Instrument and Valves Response Center using the 
1-800-654-RSMT (7768) toll-free number. This center, available 24 hours a day, will assist you with any 
needed information or materials.

The center will ask for product model and serial numbers, and will provide a Return Material 
Authorization (RMA) number. The center will also ask for the material to which the product was last 
exposed. Emerson Instrument and Valves Response Center representatives will explain the additional 
information and procedures necessary to return goods exposed to hazardous substances. 

For tracking and handling purposes, a separate RMA form must be completed and submitted for each 
product to be returned. The RMA request must include the product’s serial number and a detailed 
description of the problem encountered. 

Once an RMA number has been issued, a confirmation by e-mail or fax will be sent to the customer with 
the following information: 

 RMA number 

 Product and product quantities authorized for return

 Shipping address details

 RMA terms and conditions

For both in-warranty and out-of-warranty repairs, the customer is responsible for paying the outbound 
freight expense, and any applicable import and/or export duties and taxes. Emerson will pay the return 
freight expense for in-warranty repairs. 

All products/parts returned for repair, both in-warranty and out-of-warranty, should have a label 
attached detailing the failure/fault/non-conformity and its RMA number.

Note
Emerson strongly advises its customers to hold a small quantity of products in stock for immediate 
replacement of faulty or damaged units at end-user sites, thereby providing the best service.

Individuals who handle products exposed to a hazardous substance can avoid injury if they are informed 
of and understand the hazard. If the product being returned was exposed to a hazardous substance as 
defined by Occupational Safety and Health Administration (OSHA), a copy of the required Safety Data 
Sheet (SDS) for each hazardous substance identified must be included with the returned goods.
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9.8.1 Packaging and shipping of return products/parts
It is preferable that original packaging, including any anti-static and foam wrapping, be used on all 
returned products. If the original product packaging is not available, adequate packing should be used 
taking into account the method of shipment of the returned product. 

The customer is responsible for delivering the returned product to factory safely and undamaged. The 
RMA number should be clearly marked on all returned products, boxes, packages and accompanying 
paperwork. RMA requests received by the factory service department that are not clearly marked may 
experience delay in processing.

Discrepancies

Any product received without a proper RMA request will be returned to the customer at the customer’s 
expense. If any product and/or component(s) of the product listed on the request are missing from the 
box, the customer will receive notification of the discrepancy and a replacement part will not include the 
missing component(s). Any unauthorized product included with the RMA shipment may be returned at 
Emerson s discretion.
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Appendix A Specifications and Reference Data

Product Certifications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .page 157
Ordering Information, Specifications, and Drawings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .page 157

A.1  Product Certifications
To view current Rosemount 5708 Product Certifications, 
follow these steps:

1. Go to Emerson.com/Rosemount/Rosemount 5708. 

2. Scroll as needed to the green menu bar and click 
Documents & Drawings.

3. Click Manuals & Guides.

4. Select the appropriate Quick Start Guide.

A.2  Ordering Information, 
Specifications, and 
Drawings

To view current Rosemount 5708 Ordering Information, 
Specifications, and Drawings, follow these steps:

1. Go to Emerson.com/Rosemount/Rosemount 5708. 

2. Scroll as needed to the green menu bar and click 
Documents & Drawings.

3. For installation drawings, click Drawings & 
Schematics and select the appropriate document.

4. For ordering information, specifications, and 
dimensional drawings, click Data Sheets & Bulletins 
and select the appropriate Product Data Sheet.

http://www.emerson.com/en-us/catalog/rosemount-5708-solids-scanner
http://www.emerson.com/en-us/catalog/rosemount-5708-solids-scanner
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Appendix B Connection via Modbus RTU
Initial settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 159
Registers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 160
Communication examples  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 160

Note
These instructions apply to a direct connection between the DCS/SCADA system to the Rosemount™ 
5708 3D Solids Scanner directly. 

B.1 Initial settings
COM port settings:

 Baud rate = 115200

 Data bits = 8

 Parity = None

 Stop bits = 1

In order to get the values from the device, a Modbus® RTU command with function code 3 should be 
executed.

The address of the device equals its polling address + 1.
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B.2 Registers 
The relevant parameters are stored in registers 40001- 40026 (see Table B-1).All parameters are stored 

as IEEE754 floating points. Therefore, each parameter is stored in two consecutive registers. The byte 
sending order is from high to low.

B.3 Communication examples
Communication examples for a Rosemount 5708 with polling address 0:

Example A
 To retrieve the average distance, we send: 

01 03 00 00 00 02 C4 0B

 A sample reply would be: 
01 03 04 3D 85 1E 20 EE 0E 

This means that Distance = 0x3D851E20, which represents a float value of “0.065”.

Example B

To acquire all relevant parameters, we send: 
01 03 00 00 00 1A C4 01

Note
Mass value is in the chosen configured units and relevant only if the device linearization is configured to 
mass.

Table B-1.  Registers

Number Register number Parameter Units Type

1 40001 and 40002 Avg. distance m Floating point

2 40003 and 40004 Min distance m Floating point

3 40005 and 40006 Max distance m Floating point

4 40007 and 40008 Volume % (*1000) Floating point

5 40009 and 40010 4-20mA mA Floating point

6 40011 and 40012 SNR dB Floating point

7 40013 and 40014 Temperature °C Floating point

8 40015 and 40016 Temperature °F Floating point

9 40017 and 40018 Avg. level m Floating point

10 40019 and 40020 Bulk density g/cm3 Floating point

11 40021 and 40022 Mass customer unit Floating point

12 40023 and 40024 S/N number Long integer

13 40025 and 40026 Tag name First 4 chars 4 characters integer
Connection via Modbus RTU 160
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Appendix C Connection via RS-485
Physical layer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .page 161
Parameters and units . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .page 161

C.1 Physical layer
The physical layer of RS-485 is as follows:

 Baud rate = 115200

 Data bits = 8

 Parity = None

 Stop bits = 1

C.2 Parameters and units
The available parameters and their units are as follows:

Parameter Units

Avg. distance m

Min distance m

Max distance m

Volume %

4-20mA mA

SNR dB

Temperature °C

Temperature °F

Avg. level m

Bulk density g/cm3

Mass Customer units

S/N number

Tag name First 4 chars
Connection via RS-485 161
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To retrieve all 13 parameters, the Rosemount™ System Controller needs to transmit a single command. 
The packet format of the request is as follows:

 The above values are all hexadecimal

 For CRC-16, see reference implementation in Appendix A: Specifications and Reference Data

 The below table indicates the request string for retrieving data from 15 devices (polling addresses 00 
to 15): 

The packet format of the reply is as follows:

1 BYTE 1 BYTE 4 BYTES 2 BYTES

Polling address + 1 03 00 00 00 1A CRC-16

Table C-1.  Request String for Retrieving Data from Rosemount 5708

Polling address Request

00 01 03 00 00 00 1A C4 01

01 02 03 00 00 00 1A C4 32

02 03 03 00 00 00 1A C5 E3

03 04 03 00 00 00 1A C4 54

04 05 03 00 00 00 1A C5 85

05 06 03 00 00 00 1A C5 B6

06 07 03 00 00 00 1A C4 67

07 08 03 00 00 00 1A C4 98

08 09 03 00 00 00 1A C5 49

09 0A 03 00 00 00 1A C5 7A

10 0B 03 00 00 00 1A C4 AB

11 0C 03 00 00 00 1A C5 1C

12 0D 03 00 00 00 1A C4 CD

13 0E 03 00 00 00 1A C4 FE

14 0F 03 00 00 00 1A C5 2F

15 10 03 00 00 00 1A C7 40

1 BYTE 1 BYTE 1 BYTE 4 BYTES 4 BYTES 4 BYTES

Polling address + 1 03 34 Avg. 
distance

Min. 
distance

Max. distance

4 BYTES 4 BYTES 4 BYTES 4 BYTES 4 BYTES 4 BYTES

Volume 4-20 mA SNR Temp (°C) Temp (°F) Avg. level

4BYTES 4 BYTES 4 BYTES 4 BYTES 2 BYTES

Bulk density Mass S/N Tag name CRC-16
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Each of the 4-byte blocks represents a floating point value according to the IEEE-754 standard. For more 
information about the standard, refer to the following web page: 
http://standards.ieee.org/findstds/standard/754-1985.html.

Example

Suppose the reply starts as follows (in this example, we show only the first 4 bytes of payload):

Then the average distance is represented by a 4-byte-block of 0x3D851E20 which corresponds to the 
floating point value of 0.065m.

1. To verify the value, enter “3d851e20” in the hexadecimal representation text box at the 
http://babbage.cs.qc.cuny.edu/IEEE-754/index.xhtml web page.

2. To calculate CRC-16, use the http://www.lammertbies.nl/comm/info/crc-calculation.html web site. 

3. Select input type HEX.

4. Type in the string to convert and select the Calculate CRC button.

5. Look for the CRC-16 (Modbus) value in the table.

The output result is flipped. For example, if the result is 0x01C4, the two bytes to be transmitted are 
C401.

Byte number Value

00 01

01 03

02 34

03 3D

04 85

05 1E

06 20

... ...
Connection via RS-485163
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Appendix D Rosemount LinkPro Operating 
Instructions

About this document  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .page 165

Rosemount LinkPro overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .page 166
Technical specifications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .page 168
Mounting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .page 170
Rosemount LinkPro Setup  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .page 172
Modem wizard  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .page 175
Troubleshooting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .page 178

D.1 About this document
This appendix provides information required for mounting, connecting, and setting-up the Rosemount 
LinkPro. Read this information before operating and keep this manual accessible near the device.

D.1.1 Intended audience
This appendix is intended for trained personnel working with Rosemount LinkPro in conjunction with 
other Emerson™ products, such as the Rosemount™ 5708. It contains essential information and should 
be read prior to installation and operation.

D.1.2 Safety
This section provides safety instructions when using Rosemount LinkPro.

Authorized personnel
All operations described in this manual must be carried out by trained personnel authorized by the 
operator. The required personal protection equipment must be worn while working with the device.

Appropriate use
Operational reliability is ensured if the instrument is used in accordance with the specifications manual 
and possible supplementary instructions.

Due to safety and warranty reasons, any invasive work on the device not included in this manual may 
only be carried out by personnel authorized by the manufacturer. Unauthorized conversions or 
modifications are explicitly forbidden.

The internal GSM modem antenna should not be mounted outside the Rosemount LinkPro box.

Warning about misuse
Inappropriate or incorrect use of the instrument may cause application-specific hazards, e.g. vessel 
overflow or damage to system components through incorrect mounting or adjustment.
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General safety instructions
Adhere to standard regulations and guidelines while using the Rosemount LinkPro. This includes all 
safety instructions in this manual, country-specific installation standards, and all prevailing safety 
regulations and accident prevention rules.

The operator is responsible for trouble-free operation of the instrument.

Note 
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant 
to Part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful 
interference when the equipment is operated in a commercial environment. This equipment generates, 
uses, and can radiate radio frequency energy, and therefore, if not installed and used in accordance with 
this manual, may cause harmful interference to radio communications. Operation of this equipment in a 
residential area is likely to cause harmful interference in which case the user is required to correct the 
interference at his expense.

D.2 Rosemount LinkPro overview
The Rosemount LinkPro is used for easy bi-directional transfer of data between the Rosemount 5708 and 
the Rosemount 3DVision on a remote computer/system.

Such data can be measurement results, configuration, analysis, or software upgrade.

D.2.1 Components
The Rosemount LinkPro is composed of the following parts:

 Enfora GSM1318

 Modem

 ADAM 4520I RS-485 to RS-232 Converter

 Quad Band Antenna

 Terminal block

 120Ù  termination resistor

 Two M20 cable glands

 Changes or modifications to this equipment not expressly approved by the party responsible for 
compliance could void the user’s authority to operate the equipment.

 This product was tested with special accessories (shielded and twisted cables), which must be used 
with the unit to assure compliance.
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Figure D-1. Rosemount LinkPro Configuration

D.2.2 Area of application
The Rosemount LinkPro is connected via an easy and reliable standard GSM (Global System for Mobile 
Communications network) connection (using standard GSM frequencies). Regular SIM (Subscriber 
Identity Module) cards supporting GPRS (General Packet Radio System) are used for the connection.

D.2.3 Technical concept
The purpose of Rosemount LinkPro is to enable communication with Emerson products via a GSM 
network. It enables Emerson to provide excellent service to its customers, upgrade units at the click of a 
button, and is a great advantage in situations where traditional wiring would require more work and a 
higher cost.

Rosemount LinkPro is easy to install and offers great flexibility in adjustment, configuration, and remote 
diagnosis. By connecting Rosemount LinkPro to a Rosemount 5708, the user can remotely receive data, 
control the data, change the unit’s parameters, and upgrade the Rosemount 5708 from firmware, at the 
click of a button.

D.2.4 Operation
The Rosemount 5708 parameters can be adjusted using a Windows-based PC application (with the 
appropriate version of the Rosemount 3DVision software installed).

For additional wiring instructions and how to connect the Rosemount 3DVision to the Rosemount 5708 
using Rosemount LinkPro, refer to the Rosemount 5708 installation and Rosemount 3DVision operation 
instruction manuals.

D.2.5 GPRS modem
The GPRS modem is a compact, stand-alone, cellular modem. It is designed for communication with 
devices installed in remote locations using existing cellular networks.
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Components
The following figures show the outer case of the modem.

Figure D-2. Modem

The outer case of the modem includes the following:

1. Green LED indicator – Indicates GSM network registration status.

2. External SIM slot – Compartment for the SIM card with an option to lock the SIM.

3. Antenna connector – Connector for the antenna.

4. Power supply connector – Port to connect the modem to the power supply.

5. RS-232 connector – Port to connect between the modem and the converter.

D.3 Technical specifications
This chapter provides technical specifications of the modem and Rosemount LinkPro.

D.3.1 Modem specifications
This section lists the technical specifications of the modem.
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Table D-1.  Modem Technical Specifications

D.3.2 Rosemount LinkPro specifications
This section provides the technical specifications of the Rosemount LinkPro.

General

Antenna SMA connector

Radio performance

Frequency (MHz) Quad Band (850/900/1800/1900)

Sensitivity -106 dBm typical)

Transmit power Class 4 (2W@850/900 MHz; Class 1 (1W@1800/1900 MHz)

Operating power

Band Mode Average (mA) Peak (A)

GSM 850/900 1 TX/1 RX 200 1.30

GSM 1800/1900 1 TX/1 RX 160 0.92

Use of the modem out of the specified voltage range may result in damage to the device and/or 
undesirable results.

Table D-2.  Rosemount LinkPro Technical Specifications

Characteristics

Materials Polystyrene

Weight 3.13 lb (1.42 kg)

Dimensions (L � W � H) 10 x 7 �3.5-in. (255 � 180 � 90 mm) - not including cable glands

Voltage supply

Operating voltage 10 Vdc to 30 Vdc (nominal 24 Vdc)

Average power consumption (idle mode) 1.5 W

Peak power consumption (transmit mode) 18 W

Power source limitation 2A

Ambient conditions

Temperature -22 to +158 °F (-30 to +70 °C)

Protection IP66

CE Conformity

EMC Emission EN 301 489-7 V1.3.1:2005 standard harmonized under 
R&TTE Directive 1995/5/EC and EMC Directive 2004/108/EC 
Article 6(2)

Safety EN 60950-1:06; EN 60950-22:06
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Figure D-3. Product Dimensions

Dimensions are in inches (mm).

D.4 Mounting
This chapter provides information on mounting the Rosemount LinkPro.

D.4.1 Position
Select an easy-to-reach position for mounting and connecting. Wiring instructions are located on a label 
inside the unit’s front cover.

Mount the instrument to ensure optimum GSM reception. Do not mount in a closed metallic 
box/rack/container. Since the antenna was designed to be internal, the Rosemount LinkPro housing is 
made of plastic to enable maximal reception.

D.4.2 Moisture
Use the recommended cables (see Selecting connection cable page 173) and tighten the cable gland to 
protect the instrument from moisture and penetration of water.

Lead the connection cable downward in front of the cable entry for additional protection. Rain and 
condensation water can thus drain off naturally without affecting the connection.

D.4.3 Wall mounting
To mount the Rosemount LinkPro on the wall:

1. Mark the holes in accordance with the following drilling template.

Radio

Spurious emissions EN 301 511 V9.0.2

FCC approval FCC 47 CFR part15:2007, subpart B, class A

Electromechanical data

Cable entry/plug 2 � cable gland M20 x 1.5 (cable ø 8mm to13mm)

Table D-2.  Rosemount LinkPro Technical Specifications

3.5 
(90)

10 (255)

7 (180)
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Figure D-4. Drilling Template

Dimensions are in inches (mm).

 Rosemount LinkPro dimensions: 10 x 7 x 3.5-in. (255 x 180 x 90 mm)       

 Hole dimension: 0.16-in. (4 mm)

 Note
The Rosemount LinkPro is not sized 100 percent in the drilling template (Figure D-4).

2. Using a flat screwdriver, open the front cover.

3. Unscrew the six screws holding the plate.

4. Remove the internal plate holding the components.

5. Break the four wall mounting knock-outs (Figure D-5).

0.16 (4)

0.35 (9)

4.7 (120)

7.5 (190)
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Figure D-5. Wall Mounting Knock-outs

6. Using four screws, fasten the Rosemount LinkPro to the wall in the marked locations on the wall.

Note
Mount the Rosemount LinkPro with the cable glands facing downwards.

D.5 Rosemount LinkPro Setup
After mounting the Rosemount LinkPro, place the components inside as shown in Figure D-1. Perform 
the procedures in this chapter to successfully connect the various connections.

D.5.1 Connection
Note the following safety instructions:

 Connect only in the complete absence of line voltage.

 If power surges are expected, surge protectors should be installed.

 Ex applications: In hazardous areas, observe relevant regulations. Acquire the necessary approvals 
and permits for the sensors and power supply units.

 The Rosemount LinkPro is not an intrinsically safe approved product.

Knock-outs
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Selecting connection cable
The Rosemount LinkPro is connected to a power supply with a standard cable that meets local regulatory 
standards. RS-485 rated cable with screening should be used to connect the sensors. Screening is 
necessary to ensure interference-free operation with other devices. The communication cable should be 
twisted pair and shielded, rated for a RS-485 communication standard, and have 120 Ohm impedance.

Cable screening and grounding
The communication cable shield must be grounded. Connect the shield in the Rosemount 5708 
grounding point on one end and to a dedicated grounding on the other end. This can be, for example, 
the ‘-’ port of the power supply.

D.5.2 Wiring plan
This section provides details of how to connect the wires.

Power supply
Detailed information on the power supply can be found in the “Technical specifications” on page 168.

To connect to a power supply:

1. Loosen the four Rosemount LinkPro housing screws using a flat screwdriver.

2. Remove the housing cover.

3. Insert the Rosemount 5708 cable through the left gland of the Rosemount LinkPro.

4. Loosen the terminals with a small, flat screwdriver.

5. Connect the power supply wires to sockets “1” and “2” in accordance with Figure D-6. Note the 
polarity.

6. Tighten the screws of the terminal.

7. Tighten the compression nut of the cable entry. The seal ring must wrap the cable completely.

8. Connect sockets “3” and “4” with a separate cable to the Rosemount LinkPro.

9. Screw on the Rosemount LinkPro housing cover.

10.If the cable is screened, refer to “Cable screening and grounding” on page 173.
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Figure D-6. Wiring Diagram

A. Inside Rosemount LinkPro
B. Outside Rosemount LinkPro
C. To ADAM vonverter and GSM Modem
D. From power supply
E. To ADAM converter
F. 120 Ω resistor

Connecting RS-485 Wires
To connect RS-485 wires to the Rosemount LinkPro:

1. Connect two wires to sockets “5” and “6” in accordance with Figure D-6.

2. The Rosemount LinkPro is supplied with a 120 Ω resistor between sockets “5” and “6” (as shown in 
Figure D-6), Do not add another resistor.

3. Ensure there is another resistor on the far end of the RS-485 daisy chain bus.

D.5.3 Modem connection
Perform the following procedures to connect the modem to the system/computer. To install the SIM 
card into the modem:

1. Insert the SIM card into the external SIM slot.

2. Slide the SIM lock switch to the left to lock and secure the SIM card.

Note
Do not create loops, sharp bends, or crimps in the cables. 
The green LED indicator flashes in attempt to register to the GSM network. When the modem is 
registered to a network, the green LED indicator is solid.
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D.6 Modem wizard
The Modem Wizard is a software tool with a basic user interface that tests the modem for proper 
functionality and allows configuration of an Access Point Name (APN) details and mode operation. The 
Modem Wizard application supports both older Rosemount LinkPro models that include an EZ-864 
modem and the new Enfora GSM1318 modem.

Connect the Rosemount LinkPro to the computer (using RS-485 to USB/RS-232 converter) and power 
supply. Ensure no Rosemount 5708 is connected to the Rosemount LinkPro.

D.6.1 Getting started
The Modem Wizard application requires no installation and can be found in the distributor’s zone of the 
Emerson website.

Perform the following procedures to run the Modem Wizard. 

To open the Modem Wizard:

     Double-click on the Modem Wizard executable file. The Modem Wizard opens.

Figure D-7. Modem Wizard User Interface

D.6.2 Test performance
To test proper performance of the modem:
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1. In the Modem Details area, enter the COM port number in the Comport field (this field is mandatory).

2. In the SIM Number field (this field is mandatory), enter the SIM card phone number.

3. In the APN field, enter the APN. If it is unknown, contact the network provider.

4. Enter the UserID and Password in their correct fields if the GPRS network is protected.

5. Select Analyze. The wizard analyzes the modem performance. A completion dialog box appears.

6. Select OK. The log of commands is displayed in the middle pane and the results are displayed in the 
right pane (see Figure D-8).

Figure D-8. Test Results

Figure D-9. Test Completion
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D.6.3 Configure APN details
To configure the modem parameters:

1. In the Modem Details area, enter the COM port number in the Comport field (this field is mandatory).

2. In the APN field (this field is mandatory), enter the APN.

3. Enter the UserID and Password if required by the cellular network provider.

4. Select Set APN! to store the user ID and password in the modem. A confirmation window appears.

Figure D-10. Confirm APN Details

5. Select Yes to set the details in the modem. The Test Completion window appears (Figure D-9).

D.6.4 Configure mode of operation
To configure the operation mode:

1. In the Configuration menu, select the relevant mode in accordance with the following tables. A 
confirmation window appears (Figure D-11).

Table D-3.  EZ-864 modes

Table D-4.  GSM1318 modes

Note
Mode 0 (automatic band detection) is recommended for GSM1318.

Mode Modem band Region

Mode 0 GSM 900MHZ + DCS 1800MHZ Europe/Israel

Mode 1 GSM 850MHZ + PCS 1900MHZ USA - AT&T and MNV0

Mode 2 GSM 850MHZ + PCS 1900MHZ USA - T mobile & MNV0

Mode 3 GSM 900MHZ + PCS 1900MHZ Mexico

Mode Modem band Region

Mode 0 Automatic Global

Mode 1 GSM 900MHZ + DCS 1800MHZ Europe/Israel

Mode 2 GSM 850MHZ + PCS 1900MHZ USA

Mode 3 GSM 900MHZ + PCS 1900MHZ Mexico
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Figure D-11. Mode Configuration Window

2. Select Yes. The wizard configures the modem parameters. A completion dialog box appears (Figure 
D-9).

D.7 Troubleshooting
When facing a communication problem with the Rosemount LinkPro, check the following:
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1. Verify with the cellular provider that the SIM card supports GPRS data.

2. Verify with the cellular provider the APN, user name, and password (if required) needed to access the 
GPRS data.

3. Ensure that the Rosemount LinkPro is configured with the User Name and Password for GPRS Internet 
Access if required (use the Modem Wizard to configure the Rosemount LinkPro).

4. Connect the Rosemount LinkPro directly to the computer and run the Modem Wizard, fill all required 
fields and select Analyze. Ensure that the analysis passes all tests. If not, consult with the cellular 
provider or Emerson Technical Support. Ensure that the Rosemount 5708 is not connected to the 
Rosemount LinkPro while analyzing.

5. Check the power supply connected to the Rosemount LinkPro, it should be 24Vdc with a limitation 
above 1.5A.

6. Ensure that every Rosemount 5708 has a different polling address and one device use to polling 
address 00.

7. Check the RS-485 connection between the Rosemount 5708 and the Rosemount LinkPro.

8. Check for mutual grounding of the RS-485 between the power supply, Rosemount LinkPro, and 
Rosemount 5708.

9. Check the existence of 120 Ω resistors on both ends of the RS-485 bus.

10. Ensure that cable resistance is 60Ù  +/-5% between the D+ and D- ports. Ensure that there is no 
connection to the Rosemount 5708 and the communication is idle.

11. Check the LED’s behavior on the modem. The green LED should be solid when the SIM card is 
registered with the network.

12. Try calling the Rosemount LinkPro with the SIM card to check that the Rosemount LinkPro has 
acquired the network.

13. Verify that the SIM card phone number is correct.

14. Verify that the SIM card receives SMS messages. This can be tested by inserting the SIM card into a 
mobile phone and checking the options of receiving and sending SMS messages.

15. Send the following reset SMS to the Rosemount LinkPro: HW MODEM RESET (this is a case sensitive 
message).

16. Ensure that the TCP port is open in the router and forwarded to your computer.

17. Verify that your computer still has the same External IP address.

18. Re-check the External IP address of the network your computer is connected to (in websites like: 
www.whatismyip.com).
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Neck extension . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 184
Angle adapter  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 186

E.0.1 Cable extender
1. Kit contains:

2. Pass cables from antennas and extension cable through the cable glands.

Connect connectors.

Insert sealing sleeves on both sides to seal the cable extender. 

3. Tighten cable glands body to the tube at 2.5Nm (22lbs-In).

4. Tighten cable glands body to the Nut at 2.5 N-m (22 lbs-in). 

Sealing sleeve 2�

Sealing sleeves wrap
around the cable and 
inserted into the glands’
internal sealing tubes.

2.5 N-m
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E.0.2 Neck Extension

  1. Mount the neck extension only after connecting the cable extender. 

 O-rings remain in place. 

 2. Cable through neck extension. 

O-rings

18” adjustable
wrench

adjustable

wrench

3.
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E.0.3 Package components
The cable extender kit includes:

 Cable at the ordered length

 Cable case

 Two plates

 Cable extender

 Neck extension

18” adjustable
wrench

4.

5.
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E.1 Neck extension

E.1.1 Required equipment
 O-rings

 18-in. adjustable wrench

E.1.2 Assembling the neck extension
1. Mount the neck extension only after connecting the cable extender.

2. Remove nut from neck tube using an 18-in. adjustable wrench. 

Note
Ensure that O-rings remain in place.

A. O-ring

A

A
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3. Insert cable through neck extension.

4. Tighten neck extension using the 18-in. adjustable wrench.

A. Screw

5. Insert mounting plate.

A. Screw
B. Mounting plate

6. Tighten screw using the 18-in. adjustable wrench.

A

A

B
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E.2 Angle adapter

E.2.1 Parts of the adapter
 Angle adapter nut

 Angle adapter

Note
The angle adapter is available in 10° and 20° versions.

 Installation kit

Note
It is recommended to use a Rosemount-supplied 19.7-in. (50 cm) cable extender or the high 
temperature version of Rosemount 5708 with a 19.7-in. (50 cm) extended cable.

Kit components:

 2 � Clamps

 2 � M8 screws

 2 � Nuts

 2 � Washers

 2 � Large O-rings

 1 � Small O-ring
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E.2.2 Assembling the angle adapter
1. Remove nut from horn assembly.

2. Screw the angle adapter nut all the way down. 

3. Put the large O-ring in place.

A. O-ring

4. Ensure the notch at the top of the angle adapter is facing the same direction as the horns. The notch is 
designed to align the horns with the angle adapter.

A
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5. Screw the angle adapter nut up to the angle adapter.

6. Place the clamps over the angle adapter and the nut to lock them together with the screws and nuts.

7. Fit the two O-rings on top of the angle adapter.

A. O-ring

A

A
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8. Fit mounting plate over the angle adapter.

9. Secure the mounting plate with the nut.

10. Insert the assembled Rosemount 5708 (with the mounting plate mounted) into the vessel and 
direct the device to the center of the vessel.

Turn the 0° indication 
toward vessel center.
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11. Mount the Rosemount 5708 head over the angle adapter. See “Step 4: Install head” on page 20 more 
information.

12. After successful installation of the angle adapter, connect the Rosemount 5708 to the Rosemount 
3DVision and configure the angle adapter field according to the actual installation. 

Select Device > Advanced Parameters...

The angle can be between 0° and 30°. For more information on how to set the angle adapter field, 
see “Advanced parameters” on page 96. 
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